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Chapter 1

Introduction

This document describes how to install and configure the Java-enabled version of the
e*Way Intelligent Adapter for Sybase.

This Chapter Includes:
= “Overview” on page 8
= “Operational Overview” on page 9

= “System Requirements” on page 9

11 Overview

The Sybase e*Way enables the e*Gate system to exchange data with external Sybase
databases. This document describes how to install and configure the Java-enabled
version of the Sybase e*Way.

The Sybase e*Way uses the Java library to issue SQL statements to interact with Sybase
databases.

111 Intended Reader

The reader of this guide is presumed to be a developer or system administrator with
responsibility for maintaining the e*Gate system; to have expert-level knowledge of
Windows NT (or WIndows 2000) and UNIX operations and administration; to be
thoroughly familiar with Sybase and SQL functions; and to be thoroughly familiar with
Windows-style GUI operations.

112 Components

The following components comprise the Java-enabled version of the Sybase e*Way:

= e*Way Connections: The database e*Way Connections provide access to the
information necessary for connecting to a specified external system.

= stcjdbcex.jar: Contains the logic required by the e*Way to interact with the external
databases.

A complete list of installed files appears in Table 1 on page 13.
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12 Operational Overview

The Java-enabled version of the Sybase e*Way uses Java Collaborations to interact with
one or more external databases. By using the Java Collaboration Service it is possible for
e*Gate components—such as e*Way Intelligent Adapters (e*Ways) and Business Object
Brokers (BOBs)—to connect to external databases and execute business rules written
entirely in Java.

An e*Gate component is defined as Java-enabled based on the selection of the Java
Collaboration Service in the Collaboration Rule setup. For more information on the Java
Collaboration Service, see “The Java Collaboration Service” on page 22.

13 System Requirements

The Sybase e*Way is available on the following operating systems:
= Windows 2000, Windows 2000 SP1, and Windows 2000 SP2
= Windows NT 4.0 SP6a
= Solaris 2.6, 7, and 8
= AIX 4.3.3
= HP-UX 11.0 and HP-UX 11i
= Japanese Windows 2000, Windows 2000 SP1, and Windows 2000 SP2
= Japanese Windows NT 4.0 SP6a
= Japanese Solaris 2.6, 7, and 8
= Japanese HP-UX 11.0
= Compaq Tru64 V4.0F and V5.0A
To use the Sybase e*Way, you need the following:

= An e*Gate Participating Host, version 4.5.1 or later. For AIX operating systems, you
need an e*Gate Participating Host, version 4.5.1. or later.

= A TCP/IP network connection.

The client components of the databases with which the e*Way interfaces have their own
requirements; see that system’s documentation for more details.

GUI Host Requirements

To enable the GUI editors to communicate with the external system, the following items
must be installed on any host machines running the GUI editors:

= The Sybase client library 11.1.1 or 12.

= The Sybase client library must be installed on Windows NT /2000 to utilize the
build tool.
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Section 1.3

Chapter 1
System Requirements

Introduction
= Merant ODBC 4.0 driver available on the e*Gate installation cd.

= Microsoft Data Access Components (MDAC) RTM version 2.6 or greater. This
component is included in the e*Gate GUI installation.

If the GUI host machine will also be executing the Sybase e*Way, the host machine must
also meet the “Participating Host Requirements” on page 10.

Participating Host Requirements

The Sybase e*Way Installation program installs the Sybase jConnect 5.5 JDBC drivers
required to connect to the external Sybase database. These drives will be appropriate
for most Sybase implementations. Instructions on how to install, configure, and use
Sybase’s jConnect JDBC drivers can be found at:

http://www.sybase.com/detail?id=1009772#MARKER-2-144
Note: You must run the Stored Procedure scripts provided by Sybase with the jConnect

installation in order to fully utilize Stored Procedures. These scripts can be found
and downloaded by visiting the above hyperlink.

However, for implementations using protocols other than Type 4, the appropriate client
drivers must be installed.
A complete list of drivers from third party vendors can be found at:

http://industry.java.sun.com/products/jdbc/drivers

131 External System Requirements

The external system requirements are different for a GUI host machine—specifically a
machine running the ETD Editor and the Java Collaboration Editor GUIs—versus a
participating host which is used solely to run the e*Gate schema.

= Sybase Server 11.9 or 12.0.
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Chapter 2

Installation

This chapter describes how to install the Sybase e*Way.
This Chapter Includes:
= “Installing the Sybase e*Way on Windows N'T/2000” on page 11
= “Installing the Sybase e*Way on UNIX” on page 12
= “Installing the Sybase Client” on page 12
= “Files/Directories Created by the Installation” on page 13

21 Installing the Sybase e*Way on Windows NT/2000

211 Pre-installation

1 Exit all Windows programs before running the setup program, including any anti-
virus applications.

2 You must have Administrator privileges to install this e*Way.

212 Installation Procedure

To install the Sybase e*Way on a Windows NT/2000 system:
1 Login as an Administrator on the workstation on which you want to install the
e*Way.
2 Insert the e*Gate installation CD-ROM into the CD-ROM drive.

3 If the CD-ROM drive’s “Autorun” feature is enabled, the setup application should
launch automatically; skip ahead to step 4. Otherwise, use Windows Explorer or the
Control Panel’s Add/Remove Applications feature to launch the file setup.exe on
the CD-ROM drive.

4 The InstallShield setup application will launch. Follow the on-screen instructions to
install the e*Way.

Note: Be sure to install the e*Way files in the suggested “client” installation directory. The
installation utility detects and suggests the appropriate installation directory.
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Unless you are directed to do so by STC support personnel, do not change
the suggested “installation directory” setting.

22 Installing the Sybase e*Way on UNIX

221 Pre-installation

You do not require root privileges to install this e*Way. Log in under the user name that
you wish to own the e*Way files. Be sure that this user has sufficient privilege to create
files in the e*Gate directory tree.

222 Installation Procedure

To install the Sybase e*Way on a UNIX system:

1 Log in on the workstation containing the CD-ROM drive, and insert the CD-ROM
into the drive.

2 If necessary, mount the CD-ROM drive.
3 At the shell prompt, type
cd /cdrom
4 Start the installation script by typing:
setup.sh
5 A menu of options will appear. Select the “install e*Way” option. Then, follow any

additional on-screen directions.

Note: Be sure to install the e*Way files in the suggested “client” installation directory. The
installation utility detects and suggests the appropriate installation directory.
Unless you are directed to do so by STC support personnel, do not change
the suggested “installation directory” setting.

23 Installing the Sybase Client

The following instructions describe the procedure for installing the minimum
components required by the Java-enabled version of the Sybase e*Way.

To install the Sybase client application:

1 Launch the Sybase Client installation program from the Sybase installation CD.

Note: The procedure for launching the installation program will vary depending upon
your operating system.
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Installation

Note:

Section 2.4
Files/Directories Created by the Installation

When prompted to choose the type of installation, select Standard Installation and
click Next to continue.

Specify the directory and click Next to continue.

View the list of components. Select jConnect 4.2 and jConnect 5.2 if they are not
selected already and click Next to continue.

Follow the Wizard’s instructions until you reach the client installation section.

When prompted for the client installation, select Customized Install and click Next
to continue.

Specify the directory for the client installation and click Next to continue.

Clear the options for Adaptive Server Enterprise and Full Text Search Base
Product; click Next to continue.

Make sure the jConnect option is selected.

Follow the rest of the on-screen instructions using the default options.

24 Files/Directories Created by the Installation

The Sybase e*Way installation process will install the following files within the e*Gate
directory tree. Files will be installed within the “egate\client” tree on the Participating
Host and committed to the “default” schema on the Registry Host.

Table 1 Files created by the installation

e*Gate Directory File(s)
client\classes\ stcjdbex.jar
client\configs\sybase\ sybase.def
client\etd\ dbwizard.ctl
client\ThirdParty\sun\classes jdbc2_0-stdext.jar
client\ThirdParty\sybase\classes\ jconn2.jar
server\registry\repository\default\ stcewjdbcx.ctl
server\registry\repository\default\classes stcjdbex.jar
server\registry\repository\configs\sybase sybase.def
server\registry\repository\default\etd\ dbwizard.ctl
server\registry\repository\default\ThirdParty\ | jdbc2_0-stdext.jar
sun\classes\
ThirdParty\merant\classes DGbase.jar
ThirdParty\merant\classes DGsybase.jar
ThirdParty\merant\classes DGutil.jar
ThirdParty\merant\classes spy.jar
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Chapter 3
e*Way Connection Configuration

This chapter describes how to configure the Sybase e*Way Connections.
This Chapter Includes:
= “Create e*Way Connections” on page 14
= “DataSource Settings” on page 15

= “Connector Settings” on page 17

31 Create e*Way Connections

The e*Way Connections are created and configured in the Enterprise Manager.

To create and configure the e*Way Connections:

1 In the Enterprise Manager’s Component editor, select the e*Way Connections
folder.

Figure 1 The e*Way Connections Folder

@ e*Gate Enterprise Manager - eGate_Schema - |EI|£|
File Edit  “iewr Toolz  Options  Help

D] =] P L - T = v e A

[~ ] Participating Hosts
i ] Evert Types =
_| Collaboration Rules e I 13 I COTMIEGEITY

[ Services 1E|
="/ Cornections

_| Security |Create a Meve e*Way Connection |

ICnntents of 'efMay Connections'

2 On the Palette, click the New e*Way Connection button M

3 The New e*Way Connection Configuration dialog box opens. Enter a name for the
e*Way Connection and click OK.

4 Double-click the new e*Way Connection to open the e¥*Way Connection Properties
dialog box. See.
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Figure 2 e*Way Connection Properties Dialog Box

@ e*way Connection - Sybase Propert oy ] |

General |

ol Sybaze

e*iay Connection Type:

Evert Type "get" interval

Time (in miliseconds) after a retrieval returns "no
event availakble" before attempting anather

retrigval.
I 10000

e*zy Connection Configuration File:

| Find | Peswy |

(904 I Cancel | Apply | Help |

5 In the e*Way Connection Type list, click Sybase.

6 Inthe Event Type “get” interval box, enter an interval.
7 Click New to create a new e*Way Connection Configuration File.
The e*Way Connection Configuration File Editor will appear.

The e*Way Connection configuration file parameters are organized into the following
sections:

= DataSource Settings on page 15

= Connector Settings on page 17

311 DataSource Settings

The DataSource settings define the parameters used to interact with the external
database.

class

Description

Specifies the Java class in the JDBC driver that is used to implement the
ConnectionPoolDataSource interface.

Required Values
A valid class name.

The default is com.sybase.jdbc2.jdbc.SybConnectionPoolDataSource.
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ServerName
Description
Specifies the host name of the external database server.
Required Values

Any valid string.

PortNumber

Description

Specifies the port on which the server is listening for connection requests. Default is
5000

Required Values

A valid port number.

DatabaseName
Description

Specifies the name of the database instance.
Required Values

Any valid string.

user name
Description

Specifies the user name the e*Way will use to connect to the database.
Required Values

Any valid string.

password
Description

Specifies the password used to access the database.
Required Values

Any valid string.

timeout

Description
This is the login time out in seconds.

Required Values
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The default value is 300 seconds.

312 Connector Settings

The Connector settings define the high level characteristics of the e*Way Connection.

type
Description

Specifies the type of e*Way Connection. The current available type for JDBC
connections is DB.

Required Values
The default is DB.

class
Description

Specifies the class name of the JDBC connector object.
Required Values

The default is com.stc.eways.jdbcx.DbConnector.

transaction mode

This parameter specifies how a transaction should be handled.

= Automatic — e*Gate will take care of transaction control and users should not issue
a commit or rollback. If you are using XA, you must set your connection
establishment mode and your transaction mode both to Automatic.

= Manual — You will manually take care of transaction control by issuing a commit
or rollback.

Required Values
The required values are Automatic or Manual. The default is set to Automatic.
Mixing XA-Compliant and XA-Noncompliant e*Way Connections

A Collaboration can be XA-enabled if and only if all its sources and destinations are
XA-compliant e*Way Connections. However, XA-related advantages can accrue to a
Collaboration that uses one (and only one) e*Way Connection that is transactional but
not XA-compliant—in other words, it connects to exactly one external system that
supports commit/rollback (and is thus transactional) but does not support two-phase
commit (and is thus not XA-compliant). Please see the e*Gate User’s Guide for usage and
restrictions.
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connection establishment mode

This parameter specifies how a connection with the database server is established and
closed.

= Automatic indicates that the connection is automatically established when the
collaboration is started and keeps the connection alive as needed. If you are using
XA, you must set your connection establishment mode and your transaction mode
both to Automatic.

= OnDemand indicates that the connection will be established on demand as
business rules requiring a connection to the external system are performed. The
connection will be closed after the methods are completed.

= Manual indicates that the user will explicitly call the connection connect and
disconnect methods in their collaboration as business rules.

Required Values

The required values are Automatic, OnDemand or Manual. The default is set to
Automatic.

Note: If you are using Manual connection establishment mode, you must also use
Manual transaction mode.

connection inactivity timeout

This value is used to specify the timeout for the Automatic connection establishment
mode. If this is set to 0, the connection will not be brought down due to inactivity. The
connection is always kept alive; if it goes down, re-establishing the connection will
automatically be attempted. If a non-zero value is specified, the connection manager
will try to monitor for inactivity so that the connection is brought down if the timeout
specified is reached.

Required Values

Any valid string.

connection verification interval

This value is used to specify the minimum period of time between checks for
connection status to the database server. If the connection to the server is detected to be
down during verification, your collaboration’s onDown method is called. If the
connection comes up from a previous connection error, your collaboration’s onUp
method is called.

Required Values

Any valid string.
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Section 3.2
Connection Manager

32 Connection Manager

The Connection Manager allows you to define the connection functionality of your

e*Way. You choose:

= When an e*Way connection is made.

= When to close the e*Way connection and disconnect.

= What the status of your e*Way connection is.

= When the connection fails, an OnConnectionDown method is called by the

Collaboration

The Connection Manager was specifically designed to take full advantage of e*Gate
4.5.2’s enhanced functionality. If you are running e*Gate 4.5.1 or ealier, this enhanced

functionality is visible but will be ignored.

The Connection Manager is controlled in the e*Way configuration as described in
Connector Settings on page 17. If you choose to manually control the e*Way
connections, you may find the following chart helpful.

Figure 3 e*Way Connection Control methods

Automatic On-Demand Manual
onConnectionUp yes no no
onConnectionDown yes yes only if the no

connection

attempt fails
Automatic Transaction (XA) yes no no
Manual Transaction (XA) yes no no
connect no no yes
isConnect no no yes
disconnect no no yes
timeout or connect yes yes no
verify connection interval yes no no

Controlling When a Connection is Made

As a user, you can control when a connection is made. Using Connector Settings, you
can choose to have e*Way connections controlled manually — through the
Collaboration, or automatically — through the e*Way Connection Configuration. If you

choose to control the connection you can specify the following;:

= To connect when the Collaboration is loaded.

= To connect when the Collaboration is executed.

= To connect by using an additional connection method in the ETD.

= To connect by overriding any custom values you have assigned in the

Collaboration.
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= To connect by using the isConnected() method. The isConnected() method is called
per connection if your ETD has multiple connections.

Controlling When a Connection is Disconnected

In addition to controlling when a connection is made, you can also manually or
automatically control when an e*Way connection is terminated or disconnected. To
control the disconnect you can specify:

= To disconnect at the end of a Collaboration.
= To disconnect at the end of the execution of the Collaborations Business Rules.
= To disconnect during a timeout.

= To disconnect after a method call.

Controlling the Connectivity Status

You can control how often the e*Way connection checks to verify if it is still alive and
you can set how often it checks. See Connector Settings on page 17.
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Chapter 4
Implementation

This chapter discusses how to implement the Java-enabled Sybase e*Way in a
production environment. Also included is a sample configuration. This chapter
assumes that the Sybase e*Way has been successfully installed.

This Chapter Includes:

= “Implementing Java-enabled Components” on page 21

= “The Java ETD Builder” on page 22

= “Sample Scenario—Polling from a Sybase Database” on page 40

41 Implementing Java-enabled Components

An e*Way or a BOB can be Java-enabled by selecting the Java Collaboration Service in
the Collaboration Rules Properties. Either of these components can use e*Way
Connections to exchange data with external systems.

Figure 4 The Java Collaboration Service

@ Collaboration Rules - ProcessInboundTransactions Prope x|

General |Subscripti0ns| Eublicatiomns: | Collaboration Mappingl

Ea]
{n-j% ProcessinkoundTransactions

Service: IJava - I

Java Collaboration Initislizghen string: |
Service

~Collaboration Rules

}:ollaboration_rulesLDrocesslnboundTransactions class

Clear | Finel | TEst

rInitialization file

}:oIlaboration_rulesiProcesslnboundTransactions.ctl

Clear | Finel |

0K Cancel | Apply | Help |
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411 The Java Collaboration Service

The Java Collaboration Service makes it possible to develop external Collaboration
Rules that will execute e*Gate business logic using Java code. Using the Java
Collaboration Editor, you create Java classes that utilize the executeBusinessRules(),
userTerminate(), and userInitialize() methods.

For more information on the Java Collaboration Service and sub collaborations, see the
e*Gate Integrator Collaboration Services Reference Guide. For more information on the Java
ETD Editor and the Java Collaboration Editor, see the e*Gate Integrator User’s Guide.

412 Java-enabled Components

To make an e*Gate component Java-enabled, the component’s Collaboration Rule must
use the Java Collaboration Service. This requires all the intermediate components to
also be configured correctly, since there is not a direct relationship between the
e*Way/BOB and the Collaboration Service.

The e*Way/BOB requires one or more Collaborations. The Collaboration uses a
Collaboration Rule. The Collaboration Rule uses a Collaboration Service. In order for
the e*Way or BOB to be Java-enabled, the component’s Collaboration Rule must use the
Java Collaboration Service.

42 The Java ETD Builder

The Java ETD Builder is used to generate a Java-enabled ETD. The ETD Builder
connects to the external database and generates the ETD corresponding to the external
tables and procedures.

421 The Parts of the ETD

There are four possible parts to the Java-enabled Event Type Definition as shown in
Figure 5 below.

Figure 5 The Java-enabled ETD

El---'.' Elernent

(] b ethiod
oo i Parameter

= Element — This is the highest level in the ETD tree. The element is the basic
container that holds the other parts of the ETD. The element can contain fields and
methods.

= Field - Fields are used to represent data. A field can contain data in any of the
following formats: string, boolean, int, double, or float.
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= Method — Method nodes represent actual Java methods.

= Parameter — Parameter nodes represent the Java method’s parameters.

222 Using the DBWizard ETD Builder

The DBWizard ETD Builder generates Java-enabled ETDs by connecting to external
data sources and creating corresponding Event Type Definitions. The ETD Builder can
create ETDs based on any combination of tables, stored procedures, or prepared SQL
statements.

Field nodes are added to the ETD based on the tables in the external data source. Java
method and parameter nodes are added to provide the appropriate JDBC functionality.
For more information on the Java methods, refer to your JDBC developer’s reference.

To create a new ETD using the DBWizard
1 From the Options menu of the Enterprise Manager, choose Default Editor....
2 Verify that Java is selected, then click OK.
3 Click the ETD Editor button to launch the Java ETD Editor.
4

In the Java ETD Editor, click the New button to launch the New Event Type
Definition Wizard.

5 Inthe New Event Type Definition Wizard, select the DBWizard and click OK to
continue.

Figure 6 New Event Type Definition
x|

New |
5

JDEWizard SEFwizard S5Cwizard

Standard ETD

QK | Cancel | Help |

6 Enter the name of the new .xsc file you want to create or enter the name of the .xsc
file you want to edit by browsing to its location.
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Figure 7 Database Wizard - Introduction

7 Database Wizard - Introduction =

Welcome to the DataBase Builder Wizard

This Wizard helps you create an %5 file from database objects.

Would you like to:

& Create a new X5 File

" Modify an existing %5C File:

Brawse. .. |

SEEBEYOND
= Back Cancel |
7 Select your Data Source: from the drop down list and enter your User Name: and
Password:.

Figure 8 Database Wizard - DSN Selection

7 Database Wizard - DSN Selection =

Enter the database connection parameters:

Data Source:

il

User Name: I

Password: I

SEeBEYOND

< Back I Mext = I Cancel |

8 Select what type of database ETD you would like to generate. The data source you
selected in the Database Wizard - DSN Selection window is the default. Note: Do
not change this unless instructed to do so by SeeBeyond personnel.
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Figure 9 Database Wizard - ETD Type Selection

7 Database Wizard - ETD Type Selection =

‘What type of database ETD would you like to generate?
" DB2
= ORACLE

" 50L SERVER

O YSAMIADABAS-MERANT

 YSAM-ATTUNITY

" IDBEC-ODEC

SEeBEYOND

< Back I Mext = I Cancel |

9 In the Database Wizard - Object Selection window, select any combination of
Tables, Views, Procedures, or Prepared Statements you would like to include in
your .xsc file. Click Next to continue.

Figure 10 Database Wizard - Object Selection

7~ Database Wizard - Object Selection =

‘which of the fFollowing database objects would you like to include
in your %5C file?

(Select at least one)

¥ Tables

V¥ Views

¥ Procedures

SEeBEYOND

< Back I Mext = I Cancel |

10 In the Database Wizard - Tables window, click Add Tables.
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Figure 11 Database Wizard - Tables

/Datahase Wizard - Tables

Selected Tables:

Tahle | Catalog | Schema |
m Femayve |
r—Description
SEEBEYOND 2
Change: .., |

¥ Use fully-gualified table names in the generated Java code.

< Back I Mext = I Cancel |

11 In the Add Tables window, type the exact name of the database table or use
wildcard characters to return table names.

Figure 12 Add Tables

/ Add Tables

x|
Type the exact Table Mame or use Wildcard characters, Q
Table Hame: I Al Schemas Search |
™ Include system tables
Results:
Table | Cakalog | Schema |
Add Tables |
Close |

12 To see a list of valid wildcard characters, click the round ball with a question mark
located in its center.

Figure 13 Wildcards

@ wildcards
Operator  Description

wample

e any number of characters DE*

? any single character DE?

13 Select Include System Tables if you wish to include them and click Search. If your
search was successful, you will see the results in the Results window. To select the
name of the tables you wish to add to your .xsc, double click on the table name or
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highlight the table names and click Add Tables. You may also use adjacent
selections or nonadjacent selections to select multiple table names. When you have
finished, click Close.

14 In the Database Wizard - Tables window, review the tables you have selected. If
you would like to change any of the tables you have selected, click Change.

15 In the Columns Selection window, you can select or deselect your table choices.
You can also change the data type for each table by highlighting the data type and

selecting a different data type from the drop down list. Once you have completed
your choices, click OK.

Figure 14 Columns Selection

7~ Table Columns =
Table Calumns For: db_employee2

— Column Selection

| Calumn Name
EMP_INGC
LAST_MAME
FIRST_MAME HEN Sh

RATE j .BigDecimal

LAST_UPDATE java.sgl.Blob
5 java.sql.Clob

<l/=l=l<l]<]

java.sql.Date
java.sql.Time

java,sql. Timestamp

Select Al | Invert Selection | Clear Al |

* Indicates primary key

Restore Metadata | [8]4 | Cancel |

16 In the Database Wizard - Tables window, review the tables you have selected. If
you do not want to use fully-qualified table names in the generated Java code, click
to clear the check box and click Next to continue.

17 If you selected Views on the Database Wizard - Object Selection window, you are
presented with the Database Wizard - Views window. Follow steps 9 - 15 to select
and add views to your .xsc. Views are read-only.
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Figure 15 Database Wizard - Views

” Database Wizard - Views - |
Add Views...

Selected Views:

Wigw | Catalog | Schema |
DE&_CARTRIDG.. . CORDSYS
7~ Add Views |
Type the exact View Name or use Wildcard characters, o
Wigwt Marme: IDB* IAII Schemas j Search |
m' Results: 15 Records
— Description - Wigw | Catalog | Schema | -
SEEBEYOND Thers are & ¢ | DB&_CARTRIDGE_COMP... CRDSYS
DE& CARTRIDGES CRDSYS
EECI )

V' Use fully-g
DEA_MD_DIMEMSIONS

DE&_MD_EXCEPTIONS
DE&_MD_LOADER_ERRORS
DE&_MD_PARTITIONS

DBf_MD_TABLES
DEB&_MD_TABLESPACES LI
Add Views |

Close |

18 If you selected Procedures on the Database Wizard - Object Selection window, you
are presented with the Database Wizard - Procedures window. Follow steps 9 - 15
to select and add Procedures to your .xsc. If you do not want to use fully-qualified
procedure names in the generated Java code, click to clear the check box and click
Next to continue.

Figure 16 Database Wizard - Procedures

/Datahase Wizard - Procedures 3 x|
Add Procedures. ..

Selected Procedures:

Procedure | Catalog | Schema | Tvpe
DE_EMP_PROC... DGDE PROCED

7 Add Procedures |
Type the exact Procedure Mame or use Wildcard characters, o
Procedure Mame: IDB* IUser Schemas j Search |
KN
m Results: 1397 Records
SEEBEYOND- [Eeeeaizio Procedure | Catalag | Schema [ Type |
Thers are 1 para [Te"FrE pror FETCH DGDR PROC]
L |DB_EMPLOYEE_INSERT_SP [alefnl] PROCE
¥ Use Fully-qualii DE_EMPLOYEE_PROC DiGDE PROCE
el DEEMP_PACKAGE.DBEMP. .. DiGDE LIMKNC
DE]_LOMNG_MAME S¥3 FUMCT
DBI_SHORT_MAME S¥3 FUMCT
DEMS_ALERT.REGISTER Y5 LIMKMNC
DEMS_ALERT.REMOVE S¥3 LIMKNC

DEMS_ALERT.REMOVEALL S¥S LIMKRMC -
| | »
Add Procedures |
Close |
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19 If you selected Prepared Statements on the Database Wizard - Object Selection
window, you are presented with the Database Wizard - Prepared Statement
window. To add Prepared Statements to your .xsc. complete the following steps:

A Click Add to add a new prepared statement

B Enter a prepared SQL statement.

C Enter the Prepared Statement Name to be used by the statement.
D

Use the Open... or Save... buttons to open pre-existing statements or save the

current one.

E Click OK to return to the Database Wizard - Prepared Statements screen.

20 Repeat steps A-E to add additional prepared statements or click Next to continue.

Figure 17 Database Wizard - Prepared Statements

/'Datahase Wizard - Prepared Statements N x|

Add a new Prepared Statement entry, Then, define specific names for the
skaternent parameters,

Prepared Statement:

Mame | SOL Stakement

7~ Add Prepared Statement |

Prepared Statement Mame: |

—Edit Prepared Statement

=
[
] |
Open... | Save.., |
~Status < Back Cancel |

=
-
A 2
[8]4 | Cancel |

21 Enter the Java Class Name that will contain the selected tables and/or procedures
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Figure 18 Database Wizard - Class and Package

7 Database Wizard - Class and Package =

Enter the name of the Java Class that will contain the
selected database objects and the package name of the
generated class,

Java Class Mame

Package Mame

SEEBEYOND

< Back I Mext = I Cancel |

22 View the summary of the database wizard information and click Finish to begin
generating the ETD.

Figure 19 Database Wizard - Summary

/Datahase Wizard - Summary ll

The Database ‘Wizard has finished collecting information.

Review the wizard's summary, If the collected information is
carrect, click Finish ko generate an Event. Type Definition and its
associated Java classes, Otherwise, click Back to change your
selections,

Java Class Mame Imyclassname
Package Mame Imypackagename
Tablels ) db_employes

db_employesl

db_employesz

I Wigwls ) DEA_CARTRIDGE_COMPOMENTS
SEEBEYOND- Procedure(s) DE_EMP_PROC_FETCH
Prepared my_preparedstatement
Statement(s)
< Back

Cancel |

423 The Generated ETDs

The DataBase Wizard ETD builder can create three editable Event Type Definitions
(ETDs) and one non-editable Event Type Definition (ETD). These types of ETDs can
also be combined with each other. The four types of ETDs are:

= The Table ETD - The table ETD contains fields for each of the columns in the
selected table as well as the methods required to exchange data with the external

data source. To edit this type of ETD, you will need to open the .xsc in the DataBase
Wizard.
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= The View ETD - The view ETD contains selected columns from selected tables.
View ETD’s are read-only.

= The Stored Procedure ETD — The stored procedure ETD contains fields which
correspond to the input and output fields in the procedure. To edit this type of ETD,
you will need to open the .xsc in the DataBase Wizard

= The Prepared Statement ETD — The prepared statement ETD contains a result set
for the prepared statement. To edit this type of ETD, you will need to open the .xsc
in the DataBase Wizard.

s24 Editing an Existing .XSC Using the Database Wizard

If you choose to edit an existing .xsc that you have created using the Database Wizard,
do the following:

From the Options menu of the Enterprise Manager, choose Default Editor....
Verify that Java is selected, then click OK.

From the Tools menu, click ETD Editor...

From the ETD Tool menu click File and click New.

From the New Event Type Definition window, select DBWizard and click OK.

S G A W N =

On the Database Wizard - Introduction window, select Modify an existing XSC
file: and browse to the appropriate .xbs file that you would like to edit.

You are now able to edit your .xsc file.

Note: When you add a new element type to your existing .xsc, you must reselect any pre-
existing elements or you will loose them when the new .xsc is created.

If you attempt to edit an .xsc whose elements no longer exist in the database, you will see a
warning and the element will be dropped from the ETD.

43 Using ETDs with Tables, Views, Stored Procedures, and
Prepared Statements

The Insert, Delete, Update, and Execute Methods are common methods used within the
Collaboration Editor.

431 Tables

A table ETD represents a database table. It consists of fields and methods. Fields
correspond to the columns of a table while methods are the operations that you can

apply to the ETD. This allows you to perform SELECT, UPDATE, INSERT and DELETE
SQL operations in a table.
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The select() Method

To preform a select operation on a table, add a new method in the Collaboration Editor
by clicking on the method button. In the Method Properties box, define the method.
Add a rule to the method by clicking on the rule{} button. The Rule Properties dialog
box appears. Select the node and drag and drop it into the dialog box. This method
takes an empty string or a WHERE clause. For example:

getDBEmp () .getDB_EMPLOYEE () .select ("EMP_NO = 123");

The instert() Method

To preform a insert operation on a table, do the following:

1 From the Collaboration Editor, click the method button. Execute the select method
with the right concurrency for example CONCUR_UPDATABLE and scroll
sensitivity for example TYPE_FORWARD_ONLY.

2 Move to the insert row by the moveTolnsertRow method.
3 Set the fields of the table ETD
4 Insert the row by calling insertRow
This example inserts an employee record.
getDBEmp () .getDB_EMPLOYEE (ResultSet.TYPE_FORWARD_ONLY,
ResultSet.CONCUR_UPDATABLE) .select ("");
getDBEmp () .getDB_EMPLOYEE () .moveToInsertRow () ;
getDBEmp () .getDB_EMPLOYEE () . setEMP_NO (123) ;

getDBEmp () .getDB_EMPLOYEE () . SetRATE (123.45) ;
getDBEmp () .getDB_EMPLOYEE () .insertRow () ;
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Figure 20 Insert Method Business Rule

Business Rules

=18 ¥pediaDBEmp_insert : public class ¥pediaDBEmp_insert extends #pediaDBEmp_insertBase implements ICollaboratorExt
g ety SDBEmp. nsert)

{} rule : superd);

2 method : void method()

== executeBusinessRules : public boolean executeBusinessRules() throws Exception

retBoolean : boolean retBoolean = true;

rule ; get¥pediaDBEmp(). getDE_EMPLOYEE(ResultSet, TYPE_SCROLL_SENSITIVE, ResultSet, CONCUR_UPDATABLE), select(™);

rule ; get¥pediaDBEmp(). getDE_EMPLOYEEL) moveTolnsertRowd);

rule ; get¥pediaDBEmp]). getDE_EMPLOYEEL), setEMP_MO(new java.math,BigDecimal{getStandardDBEmp) . getEmployeetlumber{));

rule ; get¥pediaDBEmp] ). getDE_EMPLOYEEL) . setLAST _NAME{getStandardDEEmp]). getlastiame]));

rule ; get¥pediaDBEmp(). getDE_EMPLOYEEL), setFIRST _MAME{getStandardDBEmp]). getFirstMammel);

rule ; get¥pediaDBEmp(). getDE_EMPLOYEEL), setRATE(Double, parseDoublel{get StandardDEEmpE ). getRate()));

rule ; get¥pediaDBEmp]). getDE_EMPLOYEEL). setLAST _UPDATE(java.sql. Timestamp, valueOf{get StandardDEEmp] ). getLastUpdatel);

rule ; get¥pediaDBEmp(), getDE_EMPLOYEEL) insertRowd);

= reburn ; return retBoolean;

-2 yserlnitialize : public void userInitialized)

----- =% yserTerminate : public void userTerminate()

Figure 21 Insert Method Properties
=

Description: |><pediaDBEmp_insert

Name: |><pediaDBEmp_insert

Return
Type:
- Array

Throws: |

A
Mod;:f'i::rsss: [ public [ protected [ private

Parameters

Name: |

Typeﬂ
- Array

Documentation:

The update() Method

To perform an update operation on a table, do the following;:

1 Execute the select method with the right concurrency for example
CONCUR_UPDATEABLE and scroll sensitivity for example
TYPE_FORWARD_ONLY,

2 Move to the row that you want to update.
3 Set the fields of the table ETD
4 Insert the row by calling insertRow.

In this example, we move to the third record and update the EMP_NO and RATE
fields.

getDBEmp () . getDB_EMPLOYEE (ResultSet . TYPE_FORWARD_ONLY,
ResultSet.CONCUR_UPDATABLE) .select("");
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getDB_EMPLOYEE () .absolute(3) ;
getDB_EMPLOYEE () .setEMP_NO(123) ;
getDB_EMPLOYEE () .setRATE (123.45) ;
getDB_EMPLOYEE () .updateRow () ;

Figure 22 Update() Method Business Rule

Business Rules

-4z return ; return retBoolean;

3 yserTerminate : public void userTerminated)

Bl i 2 ({getstandardDBEmployes(), getRate), equals(™y) ;I
-1} then :
: {} rule : System,out. printin"yn == === Mo updated data for Rate...");
El-1} else : else
{} rule : System,out, printin"yn == === Updating R.ate from " + getvalkyrieDBE
{} rule : getvalkyrieDBEmplovesd), getDbEmploves(), setRATE{Double, parseDo
[k i 1 iF {getStandardDBEmployes(). getlastpdate(). equalsi™y)
-1} then :
L} rule Syskem,out, prinking™n === > Mo updated data for Last Update...");
E-1} else: else
----- {} rule : System,out, printin"yn == === Updating Last Update from " + getyalk
L} rule getValkyrieDBEmployee!), getDbEmployes]). setLAST_UPDATE(java.sc
----- {} rule : getvalkyrieDBEmploves!). getDbEmployveel).updateRowd);
[k i 1 iF {getvalkyrieDEEmplayes). getDbEmployee(). rowlpdated))
El-{} then:
: {} rule : System.out, printind"ynin = > === RECORD UPDATED");
El-1} else : else
L} rule Syskem,out, printing"intn= === > UPDATE FAILED");

userInitialize : public void userInitialized)

gt

The delete() Method

To preform a delete operation on a table do the following:

1

432 The View

Execute the select method with the right concurrency for example
CONCUR_UPDATEABLE and scroll sensitivity for example
TYPE_FORWARD_ONLY, TYPE_FORWARD_ONLY.

Move to the row that you want to delete.

Set the fields of the table ETD

Insert the row by calling insertRow.

In this example DELETE the first record of the result set.

getDBEmp () .getDB_EMPLOYEE (ResultSet.TYPE_FORWARD_ONLY,
ResultSet.CONCUR_UPDATABLE) .select ("");
getDBEmp () .getDB_EMPLOYEE() .first () ;

getDBEmp () .getDB_EMPLOYEE () .deleteRow() ;

Views are used to look at data from selected columns within selected tables. Views are
read-only.

433 The Stored Procedure

A Stored Procedure ETD represents a database stored procedure. Fields correspond to
the arguments of a stored procedure while methods are the operations that you can
apply to the ETD. It allows you to execute a stored procedure. Remember that while in
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the Collaboration Editor you can drag and drop nods from the ETD’s into the
Collaboration Editor.

Note:

Prior to using Stored Procedures, it is recommended that you run
sp_procxmode<procedure name>, anymode from the ISQL command line.
Not running this will produce unexpected behavior in your Collaboration. If you are
not the owner of the server, you may need to use sp_procxmode
dbo.<procedure name>,anymode.

Collecting Data from Output Parameters

You can collect data within a Stored Procedure Result Set by using output parameters.

An example of how to execute a stored procedure using output parameters is:

create procedure LookupGlobal

(

@inlocalID varchar,
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as
begin

select @QoutglobalProductID =
@inlocalID

locallID =
end
go

Figure 23 Stored Procedure LookUpGlobal

Tz ETD Editor: Event TypeDefinition2.xsc (Sandbox)

Fie Edit Help
DS M 2
—Event Type

[ LookUp

~ Intesmal Templates

[ LookupBlobal

A ®

— Event Type Defnitic

El-*g
=8 LookupGlobal
# RETURM_VALUE
# inlocallD
4 autglobalProduct|D
& seiull
A geihull
=% washull
= clearParameters
B execute
% getllpdateCount
i getResultSet

7

ol

@outglobalProductID varchar output )

globalProductID from SimpleLookup where

In the following image, the ETD represents the Stored Procedure “LookUpGlobal” with
two parameters, an inbound parameter (INLOCALID) and an outbound parameter
(OUTGLOBALPRODUCTID). Representing these as nodes in an ETD allows you to
drag values from other ETD'’s to the input parameters, execute the call, and collect the
output parameter data by dragging from it’s node to elsewhere.
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Returning Result Sets from Sybase, DB2, and SQL Server

The following Result Set processing returns rows into the body of the Stored Procedure.
Databases that allow this operation are Sybase, DB2, and SQL Server.

A stored procedure in a database can perform update and select operations. The
application checks what operation has been performed. For additional information on
Sybase Result Sets, please refer to your Sybase jConnect documentation.

The following methods allow you to collect this information:
getUpdateCount:

This method should be called only after a call to executeRetVal or getMoreResults, and
should be called only once per result. An int greater than 0 represents the number of
rows affected by an operation. A value of 0 means no rows were affected or the
operation is a DDL command. -1 means the result is a result set or there are no more
results.

getResultSet:

When the executeRetVal method has been used to execute the stored procedure. This
method returns the current result set if there is one. Otherwise, it returns a null value
which indicates the result is an update count or there are no more results.

getMoreResults:

Moves to the next result. This method returns true if it gets the next result set. It returns
false if it is an update count or there are no more results.

This example prints out the update count and result sets that are returned from the
stored procedures.

int iRow;
com.stc.eways.jdbcx.ResultSetAgent rs;
getpoller () .getMrsSp () .executeRetVal () ;

do
{
iRow = getpoller () .getMrsSp () .getUpdateCount () ;
System.out.println("\n*********jRow = " +
Integer.toString (iRow) ) ;

if (iRow >= 0)
{
getblobout () .setFieldl ("Number of rows affected: " +
Integer.toString (iRow) ) ;
getblobout () .send () ;
}
else
{
rs = getpoller().getMrsSp().getResultSet();
while (rs.next())
{

getblobout () .setFieldl ("Col5 = " +
Integer.toString(rs.getInt(l)) + ", Col6 = " +
Integer.toString(rs.getInt(2)) );

getblobout () .send () ;

}
}
}
while (getpoller().getMrsSp().getMoreResults()) ;
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Use an outbound parameter to enrich another ETD.

Note: When you set ResultSet. TYPE_FORWARD_ONLY and
ResultSet. CONCUR_UPDATABE, the table should have a unique index. If your
table does not, you will see the following exception
com.sysbase.jdbc2.jdbc.sybSQLException: The optimizer could not find a unique
index which it could use to scan table “name of table” for cursor
“jconnect_implicit_1.”

434 Prepared Statement

To Create a prepared statement from the DataBase Wizard:

1 Select the Prepared Statement option in the DataBase Wizard and complete the
following steps:

A Click Add to add a new prepared statement
B Enter a prepared SQL statement as shown. The question marks serve as place

holders that are later defined as the parameters in Figure 25 on page 38

Figure 24 Add Prepared Statement

-0l

Prepared Statement Mame: |f3repare_Statement_Test

—Edit Prepared Statement

Insert into EMP_TAE (Age, Mame, DeptNo) values (7, 7, 73 ;I

Qpen... | Save.., |

—Status

I

g

[8]4 | Cancel |

C Enter the Prepared Statement Name to be used by the statement.

D Use the Open... or Save... buttons to open pre-existing statements or create and
save the current one.

2 Figure 25 on page 38 shows the statement along with a table of the parameters. You
can give each parameter an appropriate name and data type. These parameters
become nodes in the prepared statement ETD and fields within the generated Java
object.
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Figure 25 Prepared Statement Summary and Parameter Modification

/'Datahase Wizard - Prepared Statements

Select the Add Button ko begin a new Prepared Statement entry.
‘when finished, define specific names for the statement
parameters in the Statement Parameters table below,

—Prepared Statement
Marme | SOL Stakement
Prepare_Statem... Insertinto EMP_TAE (Age, Ma...
Delete |
—Statement Parameters
m' Index |Mame [Tyvpe
1 param_1 java.math.BigDecimal
SEEBEYOND 2 |param_g java.lang, String
3 |param_3 java.math.BigDecimal
< Back I Mext = I Cancel

3 From the ETD Editor, save the Prepared Statement you just created.

Figure 26 TableJavaClass

= ETD Editor: TableJavaClass.xsc {Sandbox) 10l =|
File Edit Help
DEd| e |
Event Type - Event Type Definition Properties -TableJavaClassName
=" TablelavaClassMame
& @ EMP TAE (Mame) Tablelavalasshame
c:omn:it comment
dataEncoding | ASCIT

~Internal Templates roll;ackc . cditable False
-] EMP_TAR gethutal omm.lt sscEncoding | ASCIT

setéutaCornmit type ORACLE

getCatalog xscversion |0.4

zetCatalog
getSgligent
getSgligent
getPreparedSgligent
getPreparedSgligent
reset

available

nest

Teceive

Teceive

zend

zend

rawlnput

topic

publications
subszcriptions

marshal

unmarshal
readProperty
writeProperty

packageMame | TablePackageMame

r— External Templates

[9/28/2001 |5:28 PM
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Figure 27 Collaboration Rule Editor
=10l x|

File Edit WYiew Tools Help

dh
1% Destination Events
aredStatementTo [PrepStatementClass 2= = |
psEmployeeTable [3)-#
= comrnit commit =%
rollback rollback =%
getAutoCaormrmit
setAutoCommit H
getCatalog =
setCatalog setCatalog =2
getSqlagent getSqlagent =B
getSqlagent getSqlagent =B
getPreparedsglagent getPreparedSglagent =%+
getPreparedsglagent getPreparedsglagent =S H
LI reset 4 | »
{}  block| = method| @ vat] 43 Far| it £+ rulel B, switchl —+ casel LA whilel LA dol > returnl
1 throwl (0 el 00 catch :

4 Map the fields you would like to populate the table with from the Source Events to
the Destination Events.

5 Create your rules by dragging and dropping each node into the Rules window. This
particular example shows the Age, Name and Department Number of three
employees.

Figure 28 Collaboration Business Rules

Business Rules

=18 jcrPreparedsStatementTest ¢ public class jorPreparedStatement Test extends jcrPreparedStatement TestBase implements JCollaboratorExt
B jcrPreparedStatement Test : public jorPreparedStatement Test()

B executeBusinessRules ; public boolean executeBusinessRules() throws Exception

@ retBoolean : boolean retBoolean = true;

+ rule : getEmp_Tab{}.getEMP_TAB(), select(™);

-1 while : while {(getEmp_Tab(). getEMP_TAB(). nesxk())

C et} rule getPreparedstatement Tol), getPsEmployeeTabled), setageigetEmp_Tabi), getEMP_TAB(), get AGEL));

{} rule : getPreparedStatement Tol), getPsEmployvesTable), setMamedgetEmp_Tab(),getEMP_TAB(), getMNAME();

{} rule : getPreparedStatement Tol), getPsEmployvesTabled), setEmphiofgetEmp_Tabi), getEMP_TAB(), getDEPTHO));
{} rule : getPreparedStatement Tod), getPsEmployvesTabled), addBatchl);

} rule : getPreparedStatementTol). getPsEmployeeTablel). executeBatchi);

= reburn ; return retBoolean;

2 userlnitialize : public void userInitialized)

----- =% yserTerminate : public void userTerminate()

6 Run the schema and verify the new content in Employee database.

435 Batch Operations

While the Java API used by SeeBeyond does not support traditional bulk insert or
update operations, there is an equivalent feature that can achieve comparable results,
with better performance. This is the “Add Batch” capability. The only modification
required is to include the addBatch() method for each SQL operation and then the
executeBatch() call to submit the batch to the database server.

getDBEmp () .getDB_EMPLOYEE () .select ("");
while (getDBEmp () .getDB_EMPLOYEE () .next ())

{

getPSDBEmp () .getDbEmployeeUpdate () .setEmployeeNo (getDBEmp () .getDB_EMP
LOYEE () .getEMP_NO () ) ;
getPSDBEmp () .getDbEmployeeUpdate () .setNewTime (ts) ;
getPSDBEmp () .getDbEmployeeUpdate () .addBatch() ;
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getPSDBEmp () .getDbEmployeeUpdate () .executeBatch() ;

436 Database Configuration Node

The Database Configuration node allows you to manage the “transaction mode”
through the Collaboration if you have set the mode to manual in the e*Way connection
configuration. See “Connector Settings” on page 17.

For additional information on Sybase Result Sets, please refer to your Sybase jConnect
documentation.

+4 Sample Scenario—Polling from a Sybase Database

This section describes how to use the Java-enabled Sybase e*Way in a sample
implementation. This sample schema demonstrates the polling of records from a
Sybase database and converting the records into e*Gate Events.

Figure 29 shows a graphical overview of the sample schema.

Figure 29 The Database Select Scenario—Overview

= Sybase
Fileln DBselect Dsa)t(:l?as:e
e*Way e*Way | osEmpiozee
Local File ) ®
FileOut
@ @ Blob, e*Way
. Local File
® ®

The FileIn e*Way retrieves an Event (a text file) containing the database select
criteria and publishes it to the Q1 IQ.

The DBselect e*Way retrieves the Generic Event (Blob) from the IQ. This triggers
the rest of the Collaboration which has two parts.

The information in Blob is used to retrieve information from the database via the
Sybase_eWc e*Way Connection. This e*Way Connection contains information used
by the Collaboration to connect to the Sybase database.

The information retrieved from the database is copied to the Generic Event (Blob)
and published to the Q2 IQ.

The FileOut e*Way retrieves the Generic Event (Blob) from the Q2 IQ then writes it
out to a text file on the local file system.

Overview of Steps

= “Create the Schema” on page 42

The sample implementation follows these general steps:

= “Add the Event Types and Event Type Definitions” on page 42

e*Way Intelligent Adapter for Sybase User’s Guide
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= “Create the Collaboration Rules and the Java Collaboration” on page 45
= “Add and Configure the e*Ways” on page 49
= “Add and Configure the e*Way Connections” on page 51
= “Add the IQs” on page 52
= “Add and Configure the Collaborations” on page 53
= “Run the Schema” on page 54

Figure 30 Schema Configuration Steps

Create Schema

=~

Add Event Types and
ETDs

=~

Create Collaboration
Rules & the Java Collab

~ ~

Add and Configure
e*Ways

~ ~

Add and Configure
e*Way Connections

~ ~

Add IQs

=~ ~

Add and Configure
Collaborations

=~

Run the Schema

External Database Tables

The sample uses a simple external Sybase database with a table called
DB_EMPLOYEE. The table contains the following columns:
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Table 2 The DB_EMPLOYEE Table

Column Format Description
EMP_NO INTEGER The employee number.
LAST_NAME VARCHAR2 The employee’s last name.
FIRST_NAME VARCHAR2 The employee’s first name.
RATE FLOAT The employee’s pay rate.
LAST_DATE DATETIME The last transaction date for the employee

441 Create the Schema

The first step in the sample implementation is creating a new schema. After installing
the Sybase e*Way Intelligent Adapter, do the following:

—

Launch the e*Gate Enterprise Manager GUI.

Log into the appropriate Registry Host.

From the list of schemas, click New to create a new schema.

For this sample implementation, enter the name DBSelect and click Open.

The Enterprise Manager will launch and display the newly created schema.

442 Add the Event Types and Event Type Definitions

Two Event Types and Event Type Definitions are used in this sample.

N & U & W N =

= DBEmployee — This Event Type represents the layout of the employee records in

the DB_Employee table. The Event Type uses the DBEmployee.xsc Event Type
Definition. The ETD will be generated by using the Java ETD Editor’s Database
Wizard (DBWizard).

GenericBlob — This Event Type is used to pass records with no specific format
(blob). The Event Type uses the GenericBlob.xsc ETD. The ETD will be manually
created as a fixed-length ETD.

From the Options menu of the Enterprise Manager, choose Default Editor....
Verify that Java is selected, then click OK.

In the Components pane of the Enterprise Manager, select the Event Types folder.
Click the New Event Type button to add a new Event Type.

Enter the name DBEmployee and click OK.

Double-click the new DBEmployee Event Type to display its properties.

Click the New button to create a new Event Type Definition (ETD). The Java Event
Type Definition Editor will appear.

From the File menu, choose New. The New Event Type Definition dialog box will
appear.
In the New Event Type Definition dialog box, select DBWizard and click OK.
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10 Select Create a new .XSC file. Click Next to continue. See Figure 31.
Figure 31 Database Wizard Introduction

7 Database Wizard - Introduction =

Welcome to the DataBase Builder Wizard

This Wizard helps you create an %5 file from database objects.

Would you like to:

& Create a new X5 File

" Modify an existing %5C File:

Brawse. .. |

SEEBEYOND

= Back

Cancel |

11 Enter the database DNS source and login information.

A Select the Data Source from the dropdown list of ODBC data sources.
B Enter the User Name and Password used to log into the database.

Click Next to continue.
Figure 32 Database Wizard - DSN Selection

7 Database Wizard - DSN Selection =

Enter the database connection parameters;

Data Source:

User Mame: I

Password: I

SEEBEYOND

< Back I Mext = I Cancel |

12 The Database Wizard - ETD Type Selection window appears. The DNS source you
selected on the previous window is the default selection for this window. Do not
change this selection type unless instructed to do so by SeeBeyond support
personal. Click Next to continue.

13 This scenario uses a table rather than a procedure. Select Table and click Next to
continue.
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From the Database Wizard - Tables window, click Add Tables... Enter the exact
Table Name or enter any valid wildcards. From the drop down list select the
appropriate database schema and click Search. The wizard connects to the data
source and display a list of tables.

Select the table to be included in the ETD and click Next.

The Java Class Name/ Package Name dialog box will appear. Enter the Group and
Package information.

A Enter your database name as the Java Class Name.
B Enter DBEmployee for the Package Name and click Next to continue.

Click Finish to complete the Wizard. The Wizard will generate and display the
ETD.

From the File menu, choose Save.
Name the ETD DBEmployee.xsc and click OK.
From the File menu, choose Promote to Run Time and click OK when finished.

From the File menu, choose Close to exit the ETD Editor.

To create the GenericBlob Event Type and ETD:

1

2
3
4
5

10
11

12

In the Components pane of the Enterprise Manger, select the Event Types folder.
Click the New Event Type button to add a new Event Type.

Enter the name GenericBlob and click OK.

Double-click the new GenericBlob Event Type to display its properties.

Click the New button to create a new Event Type Definition. The Java Event Type
Definition Editor appears.

From the File menu, choose New.
The New Event Type Definition dialog box appears.
In the New Event Type Definition dialog box, select Standard ETD and click OK.

Read the Introduction screen, then click Next to continue. The Package Name
dialog box appears.

Enter GenericBlobPackage for the Package Name and click Next to continue.
Read the summary information and click Finish to generate the ETD.

In the Event Type Definition pane, right-click the root node, point to Add Field in
the shortcut menu, and click As Child Node.

Enter the properties for the two nodes as shown in Table 3.
Table 3 GenericBlob ETD Properties

Node Property Value
Root Node Name GenericBlob
Structure fixed
Length 0
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Node Property Value
Child Node Name Data
Structure fixed
Length 0

From the File menu, choose Save.

Enter the name GenericBlob.xsc and click OK.

From the File menu, choose Promote to Run Time and click OK when finished.
From the File menu, choose Close to exit the ETD Editor.

In the Event Type properties dialog box, click OK to save and close the Event Type.

443 Create the Collaboration Rules and the Java Collaboration

The sample scenario uses two Collaboration Rules and one Java Collaboration:

GenericPassThru — This Collaboration Rule is used to pass the GenericBlob Event
Type through the schema without modifying the Event.

DBSelect — This Collaboration Rule is used to convert the inbound Event’s selection
criteria into a SQL statement, poll the external database, and return the matching
records as an outbound Event.

DBSelectCollab — This Java Collaboration contains the logic required to
communicate with the external database.

To create the GenericPassThru Event Type:

1

a hHh W N

7

In the components pane of the Enterprise Manager, select the Collaboration Rules
folder.

Click the New Collaboration Rules button to add a new Collaboration Rule.
Name the Collaboration Rule GenericPassThru and click OK.
Click the Properties button to display the Collaboration Rule’s properties.

Click the Subscriptions tab, select the GenericBlob Event Type, and click the right
arrow.

Click the Publications tab, select the GenericBlob Event Type, and click the right
arrow.

Click OK to save the Collaboration Rule.

To create the DBSelect Event Type:

1

In the components pane of the Enterprise Manager, select the Collaboration Rules
folder.

Click the New Collaboration Rules button to add a new Collaboration Rule.
Name the Collaboration Rule DBSelect and click OK.
Click the Properties button to display the Collaboration Rule’s properties.
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5 In the Service list, click Java.

6 Click the Collaboration Mapping tab.

7 Add three instances as shown in Figure 33 below:

10

11

12

13

14

15

Figure 33 DBSelect Instances

7 Collaboration Rules - DBSelect Properties x|

Generall SUbsCHEtanE I Fublicetions  Collaboration Mapping |

Instance Mame | ETD Mode | Trigger | Manual Publizh
GenericBlobln  |GenericBlob xsc Find ..|In [v! [
GenericBlobOwt  |GenericBlob xsc Find .| cut [ [
DEEmployes DBEEmployee xsc Finel ... | in/out (] (]

Click Apply to save the current changes.
Click the General tab.
Click New to create the new Collaboration file

The Java Collaboration Editor appears. Note that Source and Destination Events are
already supplied based on the Collaboration Rule’s Collaboration Mapping (see
Figure 34).

From the View menu, choose Display Code.
This displays the Java code associated with each of the Collaboration’s rules.

From the Tools menu, choose Options, and then click Add File.... Add
\eGate\client\classes\stcjdbcx.jar and

AeGate\client\ThirdParty \sybase\classes\jconn2.jar and click OK to close each
of the dialog boxes.

In the Business Rules pane, select the retBoolean rule and click the rule button to
add a new rule.

In the Destination Events pane, expand the DBEmployee Event Type until the
select method is visible.

Drag the select method into the Rule field of the Rule Properties pane. Click OK to
close the dialog box without entering any criteria. (See Figure 34).

Figure 34 Rule Properties

Rule Properties

Description: Irule

Rule:

getDEEmployes).getDE_EMPLOYEED),. seleck) ;I
=

Documentation:

| =
J |
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16 In the Source Events pane, expand the GenericBlobIn Event Type until the Data
node is visible.

17 In the Rule Properties pane, position the cursor inside the parentheses of the select
method. Then drag the Data node from the Source Events pane into the select
method’s parentheses. (See Figure 35).

Figure 35 Rule Properties (Continued)

Rule Properties

Description: Irule

Rule:

getDEEmploveel). getDE_EMPLOYEES). select ;I

(getGenericBlobIng). getDatal))

Documentation:

I =
Ll

18 Select the newly edited rule in the Business Rules pane and click the while button
to add a new while loop beneath the current rule.

19 Drag the next method from the Destination Events pane into the Condition field of
the While Properties pane. (See Figure 36).

Figure 36 While Properties

while Properties

Description: Iwhile

Condition:
getDEEmployee().oetDE_EMPLOYEE( ). next() ;I
| -
Documentation:
I = |
sl

20 Select the newly edited while loop in the Business Rules pane and click the rule
button to add a new rule as a child to the while loop.

21 In the Destination Events pane, expand the GenericBlobOut Event Type until the
Data node is visible.

22 Drag the Data node into the Rule field of the Rule Properties pane. (See Figure 37).

Figure 37 Rule Properties

Rule Properties

Description: |rule

Rule:

getGenericBlobOut(). setDatal) ;I
[ -

Documentation:

| Tl
il
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23 In the Rule Properties pane, position the cursor inside the parentheses of the
setData() method. Then drag each of the five data nodes of DB_EMPLOYEE from
the Source Events into the parentheses of the rule. (See Figure 38).

Figure 38 Rule Properties (Continued)

Rule Properties

Description:
Irule

Condition:

gebGenericBlobOut) . setDatal ;I
getDEEmplovesd).getDE_EMPLOYEEL). getEMP_MGC()
getDBEmploveel).getDE_EMPLOYEE(). getLAST _MAME()
getDEEmployee().getDE_EMPLOYEE(). getFIRST_MAME()
getDBEmployes().getDE_EMPLOYEE(). getRATE()
getDBEEmployes().getDE_EMPLOYEE().getLAST _DATE()

)

[ -
Documentation:
I =

24 Edit the text of the condition to add a newline character and pipe (|) delimiters
between each of the five data nodes. (See Figure 39).

Figure 39 Rule Properties (Continued)

Rule Properties

Description:
Irule

Condition:

getEenericBlabOut(), setDatal™n" -
qetDBEEmployee).getDE_EMPLOYEE().getEMP_NO0 + " +
getDEEmployesd).getDE_EMPLOYEE() . getLAST_NAMED) + " +
getDEEmployeed).getDE_EMPLOYEE() . getFIRST_NAME() + " +
getDEEmplovesd). getDE_EMPLOYEE().getRATED + " +
getDEEmplovesd).getDE_EMPLOYEE().getLAST _DATEL)

)

Documentation:

| =

25 Select the newly edited rule in the Business Rules pane and click the rule button to
add a new rule inside the while loop.

26 Drag the root node of the GenericBlobOut Event into the rule field in the Rule
Properties pane.

27 Edit the rule; add a send() method as shown in Figure 40.

Figure 40 GenericBlobOut send()

Rule Properties
Description: |rule
Rule:
getGenericBlobout(). send() ;I
[~
Documentation:
| Tl
il
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28 From the File menu, choose Save to save the file.
29 From the File menu, choose Compile to compile the Collaboration
View the Output pane to ensure that there were no compiler errors.

30 From the File menu, choose Close to close the Java Collaboration Editor and return
to the Collaboration Rule.

Note that the Collaboration Rules and Initialization file fields have been
completed by close the Java Collaboration Editor.

31 Click OK to save and close the DBSelect Collaboration Rule.

444 Add and Configure the e*Ways

The sample scenario uses three e*Ways:

= FileIn — This e*Way retrieves an Event (text file) containing the database select
criteria and publishes it to the Q1 IQ.

= DBSelect — This e*Way retrieves the Generic Event (Blob) from the Q1 IQ. This
triggers the e*Way to request information from the external database (via the e*Way
Connection) and publishes the results to the Q2 IQ.

= FileOut - This e*Way retrieves the Generic Event (Blob) from the Q2 IQ then writes
it out to a text file on the local file system.

To create the Fileln e*Way:

1 In the Components pane of the Enterprise Manager, select the Control Broker and
click the New e*Way button.

2 Enter Fileln for the component name and click OK.

3 Select the newly created e*Way and click the Properties button to display the
e*Way’s properties.

4 Use the Find button to select stcewfile.exe as the executable file.
5 Click New to create a new configuration file.
6 Enter the parameters for the e*Way as shown in Table 4.

Table 4 Fileln e*Way Parameters

Section Name Parameter Value

General Settings Allowlncoming YES
AllowOutgoing NO
PerformanceTesting default

Outbound (send) settings | All default

Poller (inbound) settings PollDirectory c:\egate\data\dbSelect_In
All Others default

Performance Testing All default

7 Select Save from the File menu. Enter Fileln as the file name and click Save.
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Select Promote to Run Time from the File menu. Click OK to close the e*Way
configuration file editor.

In the Start Up tab of the e*Way properties, select the Start automatically check box.
Click OK to save the e*Way properties.

To create the DBSelect e*Way:

1

10

In the Components pane of the Enterprise Manager, select the Control Broker and
click the New e*Way button.

Enter DBSelect for the component name and click OK.

Select the newly created e*Way and click the Properties button to display the
e*Way’s properties.

Use the Find button to select stceway.exe as the executable file.
Click New to create a new configuration file.
Enter the parameters for the e*Way as shown in Table 5.

Table 5 DBSelect e*Way Parameters

Section Name Parameter Value

JVM Settings All default

Select Save from the File menu. Enter DBSelect as the file name and click Save.

Select Promote to Run Time from the File menu. Click OK to close the
configuration file editor.

In the Start Up tab of the Business Object Broker properties, select the Start
automatically check box.

Click OK to save the e*Way’s properties.

To create the FileOut e*Way:

1

In the Components pane of the Enterprise Manager, select the Control Broker and
click the New e*Way button.

Enter FileOut for the component name and click OK.

Select the newly created e*Way and click the Properties button to display the
e*Way’s properties.

Use the Find button to select stcewfile.exe as the executable file.
Click New to create a new configuration file.
Enter the parameters for the e*Way as shown in Table 6.

Table 6 FileOut e*Way Parameters

Section Name Parameter Value
General Settings Allowlncoming NO
AllowOutgoing YES
PerformanceTesting default
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Section Name Parameter Value
Outbound (send) settings | OutputDirectory c:\egate\data\dbSelect_Out
OutputFileName dbSelect%d.dat
Poller (inbound) settings All default
Performance Testing All default

7 Select Save from the File menu. Enter FileOut as the file name and click Save.

8 Select Promote to Run Time from the File menu. Click OK to close the e*Way
configuration file editor.

9 In the Start Up tab of the e*Way properties, select the Start automatically check box.
10 Click OK to save the e*Way properties.

245 Add and Configure the e*Way Connections

The sample scenario uses one e*Way Connection:

= Sybase_eWc - This e*Way Connection connects the DBSelect component to the
external database and returns the requested records to be published to the Q2 IQ.

To create the e*Way Connection:

1 In the Components pane of the Enterprise Manager, select the e*Way Connections
folder.

2 Click the New e*Way Connection button to add a new e*Way Connection.
3 Enter Sybase_eWc for the component name and click OK.

4 Select the newly created e*Way Connection and click the Properties button to
display the e*Way Connection’s properties.

5 Select Sybase from the e*Way Connection Type dropdown list.
6 Click New to create a new configuration file.

7 Enter the parameters for the e*Way Connection as shown in Table 7.
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Table 7 Sybase_eWc e*Way Connection Parameters

Section Name Parameter Value
DataSource class default

DriverType default

ServerName Use the ODBC Data
Source Name.

PortNumber Use the port number for
your data source.

DatabaseName Use the database name
listed in your ODBC entry.

user name Use local settings.

password Use local settings.

timeout default

connector type default

class default

transaction mode default

connection establishment | default

mode

connection inactivity 0

timeout

connection verification 5 minutes

interval

8 Select Save from the File menu. Enter Sybase_eWc as the file name and click Save.

9 Select Promote to Run Time from the File menu. Click OK to close the e*Way
Connection configuration file editor.

10 Click OK to save the e*Way Connection’s properties.

146 Add the 1Qs

The sample scenario uses two IQs
= Q1 - This IQ queues the inbound Events for the DBSelect e*Way.
= Q2 - This IQ queues the outbound Events for the FileOut e*Way.

To add the IQs:

1
2
3

e*Way Intelligent Adapter for Sybase User’s Guide

In the components pane of the Enterprise Manager, select the IQ Manager.
Click the New IQ button to add a new IQ.
Enter the name Q1 and click Apply to save the IQ and leave the New IQ dialog box

open.

Enter the name Q2 and click OK to save the second IQ.
Select the IQ Manager and click the Properties button.
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6 Select the Start automatically check box and click OK to save the properties.

247 Add and Configure the Collaborations

The sample scenario uses three Collaborations:

= FileIn_PassThru — This Collaboration uses the GenericPassThru Collaboration
Rule.

= DBSelect_collab — This Collaboration uses the GenericEventToDatabase
Collaboration Rule to execute the dbCollab.class Java Collaboration file.

* FileOut_PassThru — This Collaboration uses the GenericPassThru Collaboration
Rule.

To add the Fileln_PassThru Collaboration:

1 In the components pane of the Enterprise Manager, select the FileIn e*Way.
Click the New Collaboration button to create a new Collaboration.
Enter the name FileIn_PassThru and click OK.
Select the newly created Collaboration and click the Properties button.
Select GenericPassThru from the dropdown list of Collaboration Rules.
Click the upper Add button to add a new Subscription.
Select the GenericEvent Event Type and the <External> source.

Click the lower Add button to add a new Publication.

© & N O G s~ W DN

Select the GenericEvent Event Type and the Q1 destination.

10 Click OK to close the Collaboration’s properties.
To add the DBselect_collab Collaboration:

1 In the components pane of the Enterprise Manager, select the DBSelect e*Way.

Click the New Collaboration button to create a new Collaboration.
Enter the name DBselect_collab and click OK.
Select the newly created Collaboration and click the Properties button.
Select GenericEventToDatabase from the dropdown list of Collaboration Rules.
Click the upper Add button to add a new Subscription.
Select the GenericEvent Event Type and the FileIn_PassThru source.
click the lower Add button to add a new Publication.

© S N o G s~ W N

Select the DBEmployee Event Type and the Sybase_CP destination.

-
S

Click the lower Add button to add a new Publication.

—
=

Select the GenericEvent Event Type and the Q2 destination.

—_—
N

Click OK to close the Collaboration’s properties.
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To add the FileOut_PassThru Collaboration:
1 In the components pane of the Enterprise Manager, select the FileOut e*Way:.
Click the New Collaboration button to create a new Collaboration.
Enter the name FileOut_PassThru and click OK.
Select the newly created Collaboration and click the Properties button.
Select GenericPassThru from the dropdown list of Collaboration Rules.
Click the upper Add button to add a new Subscription.
Select the GenericEvent Event Type and the DBSelect_collab source.
Click the lower Add button to add a new Publication.

© &0 N O G s~ W N

Select the GenericEvent Event Type and the <External> destination.

—_
(=

Click OK to close the Collaboration’s properties.

448 Run the Schema

Running the sample Schema requires that a sample input file be created. Once the input
file has been created, you can start the Control Broker from a command prompt to
execute the Schema. After the Schema has been run, you can view the output text file to
verify the results.

The sample input file

Use a text editor to create an input file to be read by the inbound file e*Way (Fileln).
This simple input file contains the criteria for the dbSelect.class Collaboration’s select
statement. An example of an input file is shown in Figure 41.

Figure 41 Sample Input File

i DBselectInput.fin - Notepad 1Ol x|
File Edit Format Help

vhere EMP_HD > 99 =]
1 v 2

To start the Control Broker:
From a command prompt, type the following command:

stceb -1n logical name -rh registry -rs DBSelect -un user name
-up password

where
logical_name is the logical name of the Control Broker,
registry is the name of the Registry Host, and

user_name and password are a valid e*Gate username/password combination.
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To verify the results:

Use a text editor to view the output file c:\eGate\data\dbSelect_out\dbSelect0.dat.
Figure 42 shows an example of the records that were returned by the sample schema.

Figure 42 Sample Output File

4] dbSelect0.dat - Notepad

ol x|
File Edit Format Help

188|Krabappel|Edna|41.56|1269-11-86 18:82:38.8 ﬂ
181|Flanders|Hed|23.96|1944-04-18 B8:58:50.0

182 |Brockman |Kent |38.49|1947-12-23 87:20:85.8
183 | Skinner |Seymour |44 .53|1917-089-20 10:52:26.0
184|Simpson|Bartholomew|16.8%]|1949-89-22 14:21:58.8

-
4]
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The Sybase e*Way contains Java methods that are used to extend the functionality of
the e*Way. These methods are contained in the following classes:

= com.stc.eways.jdbcx.StatementAgent Class on page 56

= com.stc.eways.jdbcx.PreparedStatementAgent Class on page 66

= com.stc.eways.jdbcx.PreparedStatementResultSet Class on page 78
= com.stc.eways.jdbcx.SqlStatementAgent Class on page 104

= com.stc.eways.jdbcx.CallableStatementAgent Class on page 106

= com.stc.eways.jdbcx. TableResultSet Class on page 118

51 com.stc.eways.jdbcx.StatementAgent Class

java.lang.Object

+ - - com.stc.eways.jdbcx.StatementAgent

All Implemented Interfaces
ResetEventListener, SessionEventListener
Direct Known Subclasses
PreparedStatementAgent, SQLStatementAgent, TableResultSet

public abstract class StatementAgent

extends java.lang.Object
Implements SessionEventListener, ResetEventListener

Abstract class for other Statement Agent.
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Methods of the StatementAgent

cancel on page 64

clearWarnings on page 65
getFetchDirection on page 61
getMaxFieldSize on page 63
getMoreResults on page 64
getResultSetConcurrency on page 60
getUpdateCount on page 63
isClosed on page 58

queryName on page 58
resultSetConcurToString on page 58
resultSetTypeToString on page 57
sessionOpen on page 59
setEscapeProcessing on page 60
setMaxFieldSize on page 63
setQueryTimeout on page 61

stmtInvoke on page 65

Section 5.1
com.stc.eways.jdbcx.StatementAgent Class

clearBatch on page 64
executeBatch on page 64
getFetchSize on page 62
getMaxRows on page 62
getResultSet on page 63
getResultSetType on page 59
getWarnings on page 65
queryDescription on page 58
resetRequested on page 59
resultSetDirToString on page 57
sessionClosed on page 59
setCursorName on page 60
setFetchDirection on page 61
setMaxRows on page 62

setQueryTimeout on page 61

resultSetTypeToString

This method gets the symbol string corresponding to the ResultSet type enumeration.

public static java.lang.String resultSetTypeToString(int type)

Name

Description

type ResultSet type.

Returns

Enumeration symbol string.

resultSetDirToString

This method gets the symbol string corresponding to the ResultSet direction

enumeration.

public static java.lang.String resultSetDirToString(int dir)

Name

Description

dir ResultSet scroll directions.
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Returns

Enumeration symbol string.

Section 5.1

com.stc.eways.jdbcx.StatementAgent Class

resultSetConcurToString

This method gets the symbol string corresponding to the ResultSet concurrency

enumeration.

public static java.lang.String resultSetConcurToString(int concur)

Name Description

concur ResultSet concurrency.

Returns

Enumeration symbol string.

isClosed

This method returns the statement agent’s close status.

public boolean isClosed()

Returns

True if the statement agent is closed.

queryName

This method supplies the name of the listener.
public java.lang.String queryName ()
Specified By
queryName in interface SessionEventListener.
Returns

The listener’s class name.

queryDescription

This method gives a description of the query.

public java.lang.String queryDescription()

Returns

The description of the query.
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sessionOpen

Opens the session event handler.
public void sessionOpen (SessionEvent evt)
Specified by

sessionOpen in interface SessionEventListener

Name Description

evt Session event.

sessionClosed

Closes the session event handler.
public void sessionClosed(SessionEvent evt)
Specified by

sessionClosed in interface SessionEventListener

Name Description

evt Session event.

resetRequested

Resets the event handler.
public void resetRequested(ResetEvent evt)
Specified by

resetRequested in interface ResetEventListener

Name Description

evt Requested Reset event.

Throws

java.sql.SQLException

getResultSetType

Returns the result set scroll type.l
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public int getResultSetType()
Returns

ResultSet type
Throws

java.sql.SQLException

getResultSetConcurrency

Returns the result set concurrency mode.

public int getResultSetConcurrency ()

Returns
ResultSet concurrency
Throws

java.sql.SQLException

setEscapeProcessing

Sets escape syntax processing

public void setEscapeProcessing (boolean bEscape)

Name Description

bEscape True to enable
False to disable

Throws

java.sql.SQLException

setCursorName

Sets result set cursor name.

public void setCursorName (java.lang.String sName)

Name Description

sName Cursor name.

Throws

java.sql.SQLException
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setQueryTimeout

Returns query timeout duration.

public int getQueryTimeout ()
Returns

The number of seconds to wait before timeout.
Throws

java.sql.SQLException

setQueryTimeout

Sets the query timeout duration

public void setQueryTimeout (int nInterval)

Name Description
ninterval The number of seconds before timeout.
Throws
java.sql.SQLException
getFetchDirection

Returns result set fetch direction.

public int getFetchDirection ()
Returns

The fetch direction of the ResultSet: FETCH_FORWARD, FETCH_REVERSE,
FETCH_UNKNOWN.

Throws

java.sql.SQLException

setFetchDirection

Sets result set fetch direction.

public void setFetchDirection (int iDir)

e*Way Intelligent Adapter for Sybase User’s Guide 61 SeeBeyond Proprietary and Confidential



Chapter 5 Section 5.1

Sybase e*Way Methods com.stc.eways.jdbcx.StatementAgent Class
Name Description
iDir The fetch direction of the ResultSet:

FETCH_FORWARD, FETCH_REVERSE,
FETCH_UNKNOWN.

Throws

java.sql.SQLExeption

getFetchSize

Returns the result set prefetch record count.

public int getFetchSize()
Returns

The fetch size this StatementAgent object set.
Throws

java.sql.SQLException

getMaxRows

Returns the maximum number of fetch records.

public int getMaxRows ()
Returns

The maximum number of rows that a ResultSetAgent may contain.
Throws

java.sql.SQLException

setMaxRows

Sets the maximum number of fetch records.

public void setMaxRows (int nRow)

Name Description
nRow The maximum number of rows in the
ResultSetAgent.
Throws
java.sql.SQLException
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getMaxFieldSize

Returns the maximum field data size.

public int getMaxFieldSize()
Returns

The maximum number of bytes that a ResultSetAgent column may contain; 0 means no
limit.
Throws

java.sql.SQLException

setMaxFieldSize

Sets the maximum field data size.

public void setMaxFieldSize (int nSize)

Name Description
nSize The maximum size for a column in a
ResultSetAgent.
Throws
java.sql.SQLException
getUpdateCount

Returns the records count of the last executed statement.

public int getUpdateCount ()
Returns

The number of rows affected by an updated operation. O if no rows were affected or
the operation was a DDL command. -1 if the result is a ResultSetAgent or there are no
more results.

Throws

java.sql.SQLException

getResultSet

Returns the result set of the last executed statement.

public ResultSetAgent getResultSet ()
Returns

The ResultSetAgent that was produced by the call to the method execute.
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Throws

java.sql.SQLExcetpion

getMoreResults

Returns if there are more result sets.

public boolean getMoreResults ()
Returns

True if the next result is a ResultSetAgent; False if it is an integer indicating an update
count or there are no more results).

Throws

java.sql.SQLException

clearBatch

Clears the batch operation.

public void clearBatch()
Throws

java.sql.SQLException

executeBatch

Executes batch statements.

public int[] executeBatch ()
Returns

An array containing update counts that correspond to the commands that executed
successfully. An update count of -2 means the command was successful but that the
number of rows affected is unknown.

Throws

java.sql.SQLException

cancel

Cancels a statement that is being executed.

public void cancel ()

Throws

java.sql.SQLException
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getWarnings

Returns SQL warning object.

public java.sgl.SQLWarning getWarnings ()
Returns

The first SQL warning or null if there are no warnings.
Throws

java.sql.SQLException

clearWarnings
Clear all SQL Warning objects.

public void clearWarnings ()

Throws

java.sql.SQLException

stmtlinvoke

Invokes a method of the database Statement object of this ETD.

public java.lang.Object stmtInvoke (java.lang.String methodName,
java.lang.Class[] argsCls, java.lang.Object[] args)

Name Description
methodName The name of the method.
argsCls Class array for types of formal arguments

for method, in the declared order. Can be
null if there are no formal arguments.
However, cannot invoke constructor here.

args Object array of formal arguments for
method in the declared order. Can be null
if there are no formal arguments. However,
cannot invoke constructor here.

Returns

The Object instance resulting from the method invocation. Can be null if nothing is
returned (void return declaration).

Throws

java.lang.Exception. Whatever exception the invoked method throws.
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52 com.stc.eways.jdbcx.PreparedStatementAgent Class

java.lang.Object

+ --com.stc.eways.jdbcx.StatementAgent

+ -- com.stc.eways.jdbcx.PreparedStatementAgent

All Implemented Interfaces
ResetEventListener, SessionEventListener

Direct Known Subclasses
CallableStatementAgent

public class PreparedStatementAgent

extends StatementAgent
Agent hosts PreparedStatement Object
Methods of the PreparedStatementAgent

addBatch on page 77
execute on page 77
executeUpdate on page 77
setArray on page 75
setBigDecimal on page 71
setBlob on page 76
setByte on page 69
setCharacterStream on page 75
setDate on page 71
setDouble on page 71
setInt on page 70

setNull on page 67
setObject on page 68
setRef on page 76
setString on page 73
setTime on page 72

setTimestamp on page 73

clearParameters on page 77
executeQuery on page 77
sessionOpen on page 108
setAsciiStream on page 74
setBinaryStream on page 74
setBoolean on page 69
setBytes on page 74
setClob on page 76

setDate on page 72
setFloat on page 70
setLong on page 70
setObject on page 67
setObject on page 68
setShort on page 69
setTime on page 72

setTimestamp on page 73

sessionOpen

Opens the session event handler.
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public void sessionOpen (SessionEvent evt)
Overrides

sessionOpen in class StatementAgent

Name Description

evt Session event.

setNull

Nullify value of indexed parameter.

public void setNull (int index, int type)

Name Description
index Parameter index starting from 1.
type A JDBC type defined by inava.sql.Types
Throws
java.sql.SQLException
setNull

Nullify value of indexed parameter.

public void setNul (int index, int type, java.lang.String tname)

Name Description
index Parameter index starting from 1.
type A JDBC type defined by inava.sql.Types
tname The fully-qualified name of the parameter

being set. If type is not REF, STRUCT,
DISTINCT, or JAVA_OBJECT, this parameter
will be ignored.

Throws

java.sql.SQLException

setObject

Sets value of indexed parameter with an object.

e*Way Intelligent Adapter for Sybase User’s Guide 67 SeeBeyond Proprietary and Confidential



Chapter 5
Sybase e*Way Methods

Section 5.2

com.stc.eways.jdbcx.PreparedStatementAgent Class

public void setObject (int index, java.lang.Object ob)

Name Description
index Parameter index starting from 1.
ob An instance of a Java Object containing the
input parameter value.
Throws
java.sql.SQLException
setObject

Sets value of indexed parameter with an object.

public void setObject (int index, java.lang.Object ob, int iType)

Name Description
index Parameter index starting from 1.
ob An instance of a Java Object containing the
input parameter value.

iType A JDBC type defined by inava.sql.Types

Throws
java.sql.SQLException

setObject

Sets value of indexed parameter with an object.

public void setObject (int index, java.lang.Object ob, int iType, int

iScale)

Name

Description

index

Parameter index starting from 1.

ob

An instance of a Java Object containing the
input parameter value.

iType

A JDBC type defined by inava.sql.Types

iScale

The number of digits to the right of the
decimal point. Only applied to DECIMAL
and NUMERIC types
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Throws

java.sql.SQLException

setBoolean

Sets the boolean value of the indexed parameter.

public void setBoolean(int index, boolean b)

Name Description
index Parameter index starting from 1.
b true or false.
Throws
java.sql.SQLException
setByte

Sets the byte value of the indexed parameter.

public void setByte(int index, byte byt)

Name Description
index Parameter index starting from 1.
byt The byte parameter value to be set.
Throws
java.sql.SQLException
setShort

Sets the short value of the indexed parameter.

public void setShort (int index, short si)

Name Description
index Parameter index starting from 1.
si The short parameter value to be set.
Throws
java.sql.SQLException
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setint

Sets the integer value of the indexed parameter.

public void setInt(int index, int 1)

Name Description

index Parameter index starting from 1.

i The integer parameter value to be set.

Throws

java.sql.SQLException

setLong

Sets the long value of the indexed parameter.

public void setLong(int index, long 1)

Name Description

index Parameter index starting from 1.

I The long parameter value to be set.

Throws

java.sql.SQLException

setFloat

Sets the float value of the indexed parameter.

public void setFloat (int index, float f)

Name Description
index Parameter index starting from 1.
f The float parameter value to be set.
Throws
java.sql.SQLException
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setDouble

Sets the double value of the indexed parameter.

public void setDouble(int index, double d)

Name Description
index Parameter index starting from 1.
d The double parameter value to be set.
Throws
java.sql.SQLException
setBigDecimal

Sets the decimal value of the indexed parameter.

public void setBigDecimal (int index, java.math.BigDecimal dec)

Name Description
index Parameter index starting from 1.
dec The BigDecimal parameter value to be set.
Throws
java.sql.SQLException
setDate

Sets the date value of the indexed parameter.

public void setDate(int index, java.sqgl.Date date)

Name Description
index Parameter index starting from 1.
date The Date parameter value to be set.
Throws
java.sql.SQLException
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setDate
Sets the date value of indexed parameter with time zone from calendar.
public void setDate(int index, java.sqgl.Date date, java.util.Calendar
cal)
Name Description
index Parameter index starting from 1.
date The Date parameter value to be set.
cal The calender object used to construct the
date.
Throws
java.sql.SQLException
setTime
Sets the time value of the indexed parameter.
public void setTime(int index, java.sqgl.Time t)
Name Description
index Parameter index starting from 1.
t The Time parameter value to be set.
Throws
java.sql.SQLException
setTime

Sets the time value of the indexed parameter.

public void setTime(int index, java.sqgl.Time t, java.util.Calendar

cal)

Name

Description

index

Parameter index starting from 1.

The Time parameter value to be set.

cal

The Calendar object used to construct the
time.
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Throws
java.sql.SQLException
setTimestamp
Sets the timestamp value of the indexed parameter.
public void setTimestamp (int index, java.sqgl.Timestamp ts)
Name Description
index Parameter index starting from 1.
ts The Timestamp parameter value to be set.
Throws
java.sql.SQLException
setTimestamp
Sets the timestamp value of the indexed parameter with the time zone from the
calendar.
public void setTimestamp (int index, java.sqgl.timestamp ts,
java.util.Calendar cal)
Name Description
index Parameter index starting from 1.
ts The Timestamp parameter value to be set.
cal The Calendar object used to construct the
timestamp.
Throws
java.sql.SQLException
setString

Sets the string value of the indexed parameter.

public void setString(int index, java.lang.String s)

Name Description

index Parameter index starting from 1.
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Name Description
s The String parameter value to be set.
Throws
java.sql.SQLException
setBytes

Sets the byte array value of the indexed parameter.

public void setBytes (int index, byte[] bytes)

Name Description
index Parameter index starting from 1.
bytes The byte array parameter value to be set.
Throws
java.sql.SQLException
setAsciiStream
Sets the character value of the indexed parameter with an input stream and specified
length.
public void setAsciiStream(int index, java.io.InputStream is, int
length)
Name Description
index Parameter index starting from 1.
is The InputStream that contains the Ascii
parameter value to be set.
length The number of bytes to be read from the
stream and sent to the database.
Throws
java.sql.SQLException
setBinaryStream
Sets the binary value of the indexed parameter with an input stream and specified
length.
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public void setBinaryStream(int index, java.io.InputStream is, int

length)
Name Description
index Parameter index starting from 1.
is The InputStream that contains the binary
parameter value to be set.
length The number of bytes to be read from the
stream and sent to the database.
Throws
java.sql.SQLException
setCharacterStream
Sets the character value of the indexed parameter with a reader stream and specified
length.
public void setCharacterStream(int index, java.io.Reader rd, int
length)
Name Description
index Parameter index starting from 1.
rd The Reader that contains the Unicode
parameter value to be set.
length The number of characters to be read from
the stream and sent to the database.
Throws
java.sql.SQLException
setArray

Sets the Array value of the indexed parameter.

public void setArray(int index, java.sqgl.Array a)

Name Description
index Parameter index starting from 1.
a The Array value to be set.
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Throws

java.sql.SQLException

setBlob

Sets the Blob value of the indexed parameter.

public void setBlob(int index, java.sgl.Blob blob)

Name Description
index Parameter index starting from 1.
blob The Blob value to be set.
Throws
java.sql.SQLException
setClob

Sets the Clob value of the indexed parameter.

public void setClob(int index, java.sgl.Clob clob)

Name Description
index Parameter index starting from 1.
clob The Clob value to be set.
Throws
java.sql.SQLException
setRef

Sets the Ref value of the indexed parameter.

public void setRef (int index, java.sgl.Ref ref)

Name Description
index Parameter index starting from 1.
ref The Ref parameter value to be set.
Throws
java.sql.SQLException
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clearParameters

Clears the parameters of all values.

public void clearParameters()

Throws

java.sql.SQLException

addBatch

Adds a set of parameters to the list of commands to be sent as a batch.

public void addBatch ()
Throws

java.sql.SQLException

execute

Executes the Prepared SQL statement.

public void execute()

Throws

java.sql.SQLException

executeQuery

Executes the prepared SQL query and returns a ResultSetAgent that contains the
generated result set.

public ResultSetAgent executeQuery ()
Returns

ResultSetAgent or null.
Throws

java.sql.SQLException

executeUpdate

Executes the prepared SQL statement and returns the number of rows that were
affected.

public int executeUpdate()
Returns

The number of rows affected by the update operation; 0 if no rows were affected.
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Throws

java.sql.SQLException

53 com.stc.eways.jdbcx.PreparedStatementResultSet
Class

java.lang.Object
|
+ -- com.stc.eways.jdbcx.PreparedStatementResultSet

public abstract class PreparedStatementResultSet

extends java.lang.Object
Base class for Result Set returned from a Prepared Statement execution.
Constructors of PreparedStatementResultSet

PreparedStatementResultSet

e*Way Intelligent Adapter for Sybase User’s Guide 78 SeeBeyond Proprietary and Confidential



Chapter 5
Sybase e*Way Methods

Methods of PreparedStatementResultSet

absolute on page 82
beforeFirst on page 84
close on page 82
findColumn on page 85
getArray on page 99
getAsciiStream on page 98
getBigDecimal on page 91
getBinaryStream on page 98
getBlob on page 100
getBoolean on page 87
getByte on page 88
getBytes on page 97
getCharacterStream on page 99
getClob on page 100
getConcurrency on page 80
getDate on page 92
getDate on page 93
getDouble on page 91
getFetchDirection on page 80
getFloat on page 90

getInt on page 89

getLong on page 89
getMetaData on page 80
getObject on page 86
getObject on page 87
getRef on page 102
getShort on page 88
getString on page 96
getTime on page 93
getTime on page 94
getTimestamp on page 95
getTimestamp on page 95
getType on page 85
insertRow on page 103

isBeforeFirst on page 84

e*Way Intelligent Adapter for Sybase User’s Guide

Section 5.3
com.stc.eways.jdbcx.PreparedStatementResultSet Class

afterLast on page 84
clearWarnings on page 102
deleteRow on page 103
first on page 83

getArray on page 99
getAsciiStream on page 98
getBigDecimal on page 92
getBinaryStream on page 99
getBlob on page 100
getBoolean on page 87
getByte on page 88
getBytes on page 97
getCharacterStream on page 99
getClob on page 101
getCursorName on page 82
getDate on page 92
getDate on page 93
getDouble on page 91
getFetchSize on page 81
getFloat on page 91

getInt on page 89

getLong on page 90
getObject on page 85
getObject on page 86
getRef on page 101
getRow on page 103
getShort on page 88
getString on page 96
getTime on page 93
getTime on page 94
getTimestamp on page 95
getTimestamp on page 96
getWarnings on page 102
isAfterLast on page 85
isFirst on page 83

SeeBeyond Proprietary and Confidential



Chapter 5 Section 5.3

Sybase e*Way Methods com.stc.eways.jdbcx.PreparedStatementResultSet Class
isLast on page 84 last on page 83
next on page 82 previous on page 82
refreshRow on page 124 relative on page 83
getFetchDirection on page 80 getFetchSize on page 81
updateRow on page 103 wasNull on page 102

Constructor PreparedStatementResultSet

Constructs a Prepared Statement Result Set object.

public PreparedStatementResultSet (ResultSetAgent rsAgent)

Name Description

rsAgent The ResultSetAgent underlying control.

getMetaData

Retrieves a ResultSetMetaData object that contains ResultSet properties.

public java.sgl.ResultSetMetaData getMetaData()
Returns

ResultSetMetaData object
Throws

java.sql.SQLException

getConcurrency

Gets the concurrency mode for this ResultSet object.

public int getConcurrency ()

Returns
Concurrency mode
Throws

java.sql.SQLException

getFetchDirection

Gets the direction suggested to the driver as the row fetch direction.

public int getFetchDirection|()
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Returns
Row fetch direction
Throws

java.sql.SQLException

setFetchDirection

Gives the driver a hint as to the row process direction.

public void setFetchDirection(int iDir)

Name Description
iDir Fetch direction to use.
Throws
java.sql.SQLException
getFetchSize

Gets the number of rows to fetch suggested to the driver.

public int getFetchSize()
Returns

Number of rows to fetch at a time.
Throws

java.sql.SQLException

setFetchSize

Gives the drivers a hint as to the number of rows that should be fetched each time.

public void setFetchSize(int nSize)

Name Description

nSize Number of rows to fetch at a time.

Throws

java.sql.SQLException
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getCursorName

Retrieves the name for the cursor associated with this ResultSet object.

public java.lang.String getCursorName ()

Returns
Name of cursor
Throws

java.sql.SQLException

close

Immediately releases a ResultSet object’s resources.

public void close()

Throws

java.sql.SQLException

next

Moves the cursor to the next row of the result set.

public boolean next ()

Returns
true if successful
Throws

java.sql.SQLException

previous

Moves the cursor to the previous row of the result set.

public boolean previous ()

Returns
true if successful
Throws

java.sql.SQLException

absolute

Moves the cursor to the specified row of the result set.

public boolean absolute(int index)
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Returns
true if successful
Throws

java.sql.SQLException

relative

Moves the cursor to the specified row relative to the current row of the result set.

public boolean relative(int index)

Returns
true if successful
Throws

java.sql.SQLException

first

Moves the cursor to the first row of the result set.

public boolean first()

Returns
true if successful
Throws

java.sql.SQLException

isFirst
Determines whether the cursor is on the first row of the result set.

public boolean isFirst()

Returns
true if on the first row.
Throws

java.sql.SQLException

last

Moves the cursor to the last row of the result set.

public boolean last ()
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Returns
true if successful
Throws

java.sql.SQLException

isLast

Determines whether the cursor is on the last row of the result set.

public boolean isLast ()

Returns
true if on the last row
Throws

java.sql.SQLException

beforeFirst

Moves the cursor before the first row of the result set.

public void beforeFirst ()

Throws

java.sql.SQLException

isBeforeFirst

Determines whether the cursor is before the first row of the result set.

public boolean isBeforeFirst()

Returns
true if before the first row
Throws

java.sql.SQLException

afterLast

Moves the cursor after the last row of the result set.

public void afterLast ()
Throws

java.sql.SQLException
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isAfterLast

Determines whether the cursor is after the last row of the result set.

public boolean isAfterLast ()
Returns

true if after the last row
Throws

java.sql.SQLException

getType
Retrieves the scroll type of cursor associated with the result set.

public int getType()
Returns

Scroll type of cursor.
Throws

java.sql.SQLException

findColumn

Returns the column index for the named column in the result set.

public int findColumn(java.lang.String index)

Name Description

index Column name.

Returns
Corresponding column index.
Throws

java.sql.SQLException

getObject

Gets the object value of the specified column.

public java.lang.Object getObject (int index)
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Name

Description

index Column index.

Returns
Object form of column value.
Throws

java.sql.SQLException

getObject

Gets the object value of the specified column.

public java.lang.Object getObject(java.lang.String index)

Name

Description

index Column index.

Returns
Object form of column value.
Throws

java.sql.SQLException

getObject

Gets the object value of the specified column using the given type map.

public java.lang.Object getObject (int index,

java.util.Map.map)

Name

Description

index Column index.

map Type map.

Returns
Object form of column value.
Throws

java.sql.SQLException
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getObject

Gets the object value of the specified column using the given type map.

public java.lang.Object getObject(java.lang.String index,
java.util.Map map)

Name Description

index Column index.

map Type map.

Returns
Object form of column value.
Throws

java.sql.SQLException

getBoolean

Gets the boolean value of the specified column.

public boolean getBoolean (int index)

Name Description

index Column index.

Returns
Boolean value of the column.
Throws

java.sql.SQLException

getBoolean

Gets the boolean value of the specified column.

public boolean getBoolean(java.lang.String index))

Name Description

index Column name.

Returns

Boolean value of the column.
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Throws

java.sql.SQLException

getByte
Gets the byte value of the specified column.

public byte getByte(int index)

Name Description

index Column index.

Returns
Boolean value of the column.
Throws

java.sql.SQLException

getShort

Gets the short value of the specified column.

public short getShort (int index)

Name Description

index Column index.

Returns
Short value of the column.
Throws

java.sql.SQLException

getShort

Gets the short value of the specified column.

public short getShort(java.lang.String index)

Name Description

index Column name.
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Returns
Short value of the column.
Throws

java.sql.SQLException

getint

Gets the integer value of the specified column.

public int getInt(int index)

Name Description

index Column index.

Returns
Int value of the column.
Throws

java.sql.SQLException

getint

Gets the integer value of the specified column.

public int getInt(java.lang.String index)

Name Description

index Column name.

Returns
Int value of the column.
Throws

java.sql.SQLException

getlLong

Gets the long value of the specified column.

public long getLong(int index)
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Name

Description

index Column index.

Returns
Long value of the column.
Throws

java.sql.SQLException

getLong

Gets the long value of the specified column.

public long getLong(java.lang.String index)

Name

Description

index Column name.

Returns
Long value of the column.
Throws

java.sql.SQLException

getFloat

Gets the float value of the specified column.

public float getFloat (int index)

Name

Description

index Column index.

Returns
Float value of the column.
Throws

java.sql.SQLException
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getFloat
Gets the float value of the specified column.
public float getFloat(java.lang.String index)
Name Description
index Column name.
Returns
Float value of the column.
Throws
java.sql.SQLException
getDouble
Gets the double value of the specified column.
public double getDouble(int index)
Name Description
index Column index.
Returns
Double value of the column.
Throws
java.sql.SQLException
getBigDecimal
Gets the decimal value of the specified column.
public java.math.BigDecimal getBigDecimal (int index)
Name Description
index Column index.
Returns

Big decimal value of the column.
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Throws
java.sql.SQLException
getBigDecimal

Gets the decimal value of the specified column.

public java.math.BigDecimal getBigDecimal (java.lang.String index)

Name

Description

index

Column name.

Returns

Big decimal value of the column.

Throws

java.sql.SQLException

getDate

Gets the date value of the specified column.

public java.sqgl.Date getDate(int index)

Name

Description

index

Column index.

Returns

Date value of the column.

Throws

java.sql.SQLException

getDate

Gets the date value of the specified column.

public java.sgl.Date getDate(java.lang.String index)

Name

Description

index

Column name.
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Returns
Date value of the column.
Throws

java.sql.SQLException

getDate

Gets the date value of the specified column using the time zone from the calendar.

public java.sqgl.Date getDate(java.lang.String index,
java.util.Calendar calendar)

Name Description

index Column name.

calendar Calendar to use.

Returns
Date value of the column.
Throws

java.sql.SQLException

getTime

Gets the time value of the specified column.

public java.sgl.Time getTime (int index)

Name Description

index Column index.

Returns
Time value of the column.
Throws

java.sql.SQLException

getTime

Gets the time value of the specified column.

public java.sgl.Time getTime (java.lang.String index)
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Name Description

index Column name.

Returns
Time value of the column.
Throws

java.sql.SQLException

getTime

Gets the time value of the specified column.

public java.sgl.Time getTime (int index, java.util.Calendar calendar)

Name Description

index Column index.

calendar Calendar to use.

Returns
Time value of the column.
Throws

java.sql.SQLException

getTime

Gets the time value of the specified column.

public java.sqgl.Time getTime(java.lang.String index,
java.util.Calendar calendar)

Name Description

index Column name.

calendar Calendar to use.

Returns
Time value of the column.
Throws

java.sql.SQLException
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getTimestamp

Gets the timestamp value of the specified column.

public java.sgl.Timestamp getTimestamp (int index)

Name

Description

index

Column index.

Returns

The timestamp value of the column.

Throws

java.sql.SQLException

getTimestamp

Gets the timestamp value of the specified column.

public java.sqgl.Timestamp getTimestamp (java.lang.String index)

Name

Description

index

Column name.

Returns

The timestamp value of the column.

Throws

java.sql.SQLException

getTimestamp

Gets the timestamp value of the specified column using the time zone from the

calendar.

public java.sqgl.Timestamp getTimestamp (int index, java.util.Calendar

calendar)

Name

Description

index

Column index.

Returns

The timestamp value of the column.
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Throws

java.sql.SQLException

getTimestamp

Gets the timestamp value of the specified column using the time zone from the
calendar.

public java.sgl.Timestamp getTimestamp (java.lang.String index,
java.util.Calendar calendar)

Name Description

index Column name.

calendar Calendar to use.

Returns
The timestamp value of the column.
Throws

java.sql.SQLException

getString

Gets the string value of the specified column.

public java.lang.String getString(int index)

Name Description

index Column index.

Returns
Returns the String value of the column.
Throws

java.sql.SQLException

getString

Gets the string value of the specified column.

public java.lang.String getString(java.lang.String index)
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Name Description

index Column name.

Returns
Returns the String value of the column.
Throws

java.sql.SQLException

getBytes

Gets the byte array value of the specified column.

public byte[] getBytes (int index)

Name Description

index Column index.

Returns
Byte array value of the column.
Throws

java.sql.SQLException

getBytes

Gets the byte array value of the specified column.

public byte[] getBytes(java.lang.String index)

Name Description

index Column name.

Returns
Byte array value of the column.
Throws

java.sql.SQLException
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getAsciiStream

Retrieves the value of the specified column value as a stream of ASCII characters.

public java.io.InputStream getAsciiStream(int index)

Name Description

index Column index.

Returns
ASCII output stream value of the column.
Throws

java.sql.SQLException

getAsciiStream

Retrieves the value of the specified column value as a stream of ASCII characters.

public java.io.InputStream getAsciiStream(java.lang.String index)

Name Description

index Column name.

Returns
ASCII output stream value of the column.
Throws

java.sql.SQLException

getBinaryStream

Retrieves the value of the specified column as a stream of uninterpreted bytes.

public java.io.InputStream getBinaryStream(int index)

Name Description

index Column index.

Returns

Binary out steam value of the column.
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Throws

java.sql.SQLException

getBinaryStream

Retrieves the value of the specified column as a stream of uninterpreted bytes.

public java.io.InputStream getBinaryStream(java.lang.String index)

Name Description

index Column name.

Returns
Binary out steam value of the column.
Throws

java.sql.SQLException

getCharacterStream

Retrieves the value of the specified column as a Reader object.

public java.io.Reader getCharacterStream(int index)

Name Description

index Column index.

Returns
Reader for value in the column.
Throws

java.sql.SQLException

getArray

Gets the Array value of the specified column.

public java.sql.Array getArray (int index)

Name Description

index Column index.
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Returns

Array value of the column.

Throws

java.sql.SQLException

Section 5.3

com.stc.eways.jdbcx.PreparedStatementResultSet Class

getBlob

Gets the Blob value of the specified column.

public java.sqgl.Blob getBlob(int index)

Name

Description

index

Column index.

Returns

Blob value of the column.

Throws

java.sql.SQLException

getBlob

Gets the Blob value of the specified column.

public java.sgl.Blob getBlob(java.lang.String index)

Name

Description

index

Column name.

Returns

Blob value of the column.

Throws

java.sql.SQLException

getClob

Gets the Clob value of the specified column.

public java.sgl.Clob getClob(int index)
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Name Description

index Column index.

Returns
Clob value of the column.
Throws

java.sql.SQLException

getClob

Gets the Clob value of the specified column.

public java.sgl.Clob getClob(java.lang.String index)

Name Description

index Column name.

Returns
Clob value of the column.
Throws

java.sql.SQLException

getRef

Gets the Ref value of the specified column.

public java.sgl.Ref getRef (int index)

Name Description

index Column index.

Returns
Ref value of the column.
Throws

java.sql.SQLException
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getRef

Gets the Ref value of the specified column.

public java.sgl.Ref getRef(java.lang.String index)

Name

Description

index Column name.

Returns
Ref value of the column.
Throws

java.sql.SQLException

wasNull

Checks to see if the last value read was SQL NULL or not.

public boolean wasNull ()

Returns
true if SQL NULL.
Throws

java.sql.SQLException

getWarnings

Gets the first SQL Warning that has been reported for this object.

public java.sgl.SQLWarning getWarnings ()

Returns
SQL warning.
Throws

java.sql.SQLException

clearWarnings

Clears any warnings reported on this object.

public void clearWarnings ()

Throws

java.sql.SQLException
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getRow

Retrieves the current row number in the result set.

public int getRow ()
Returns

Current row number
Throws

java.sql.SQLException

refreshRow

Replaces the values int the current row of the result set with their current values in the
database.

public void refreshRow/()

Throws

java.sql.SQLException

insertRow

Inserts the contents of the insert row into the result set and the database.

public void insertRow ()

Throws

java.sql.SQLException

updateRow

Updates the underlying database with the new contents of the current row.

public void updateRow ()
Throws

java.sql.SQLException

deleteRow
Deletes the current row from the result set and the underlying database.
public void deleteRow/()

Throws

java.sql.SQLException
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s4 com.stc.eways.jdbcx.SqlStatementAgent Class

java.lang.Object
|

+ -- com.stc.eways.jdbcx.StatementAgent
|
+ -- com.stc.eways.jdbcx.SqlStatementAgent
All Implemented Interfaces
ResetEventListener, SessionEventListener
public class SqlStatementAgent
extends StatementAgent
SQLStatement Agent that hosts a managed Statement object.
Constructors of the SqlStatementAgent
SqlStatementAgent
SqlStatementAgent
Methods of the SqlStatementAgent

addBatch on page 106 execute on page 105
executeQuery on page 105 executeUpdate on page 105

Constructor SqlStatementAgent

Creates new SQLStatementAgent with scroll direction TYPE_FORWARD_ONLY and
concurrency CONCUR_READ_ONLY.

public SglStatementAgent (Session session)

Name Description

session Connection session.

Constructor SqlStatementAgent

Creates a new SQLStatementAgent.

public SglStatementAgent (Session session, int iScroll, int iConcur)
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Name Description
session Connection session.
iScroll Scroll direction: TYPE_LFORWARD_ONLY,
TYPE_FORWARD_ONLY.
iConcur Concurrency: CONCUR_READ_ONLY,
CONCUR_UPDATABLE.

execute

Executes the specified SQL statement.

public boolean execute(java.lang.String sSgl)

Name Description

sSql SQL statement.

Returns
true if the first result is a ResultSetAgent or false if it is an integer.
Throws

java.sql.SQLException

executeQuery

Executes the specified SQL query and returns a ResultSetAgent that contains the
generated result set.

public ResultSetAgent executeQuery(java.lang.String sSqgl)

Name Description

sSql SQL statement.

Returns
A ResultSetAgent or null
Throws

java.sql.SQLException

executeUpdate

Executes the specified SQL statement and returns the number of rows that were
affected.
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public int executeUpdate(jave.lang.String sSqgl)

Name Description

sSql SQL statement.

Returns
The number of rows affected by the update operation; 0 if no rows were affected.
Throws

java.sql.SQLException

addBatch

Adds the specified SQL statement to the list of commands to be sent as a batch.

public void addBatch(java.lang.String sSqgl)

Name Description

sSql SQL statement.

Throws

java.sql.SQLException

s com.stc.eways.jdbcx.CallableStatementAgent Class

java.lang.Object

+ -- com.stc.eways.jdbcx.StatementAgent

+ -- com.stc.eways.jdbcx.PreparedStatementAgent
|
+ -- com.stc.eways.jdbcx.CallableStatementAgent
All Implemented Interfaces
ResetEventListener, SessionEventListener
Direct Known Subclasses
StoredProcedureAgent

public abstract class CallableStatementAgent
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extends PreparedStatementAgent
Agent hosts CallableStatement interface

Constructors of the CallableStatementAgent
CallableStatementAgent
CallableStatementAgent
CallableStatementAgent

Methods of the CallableStatementAgent

Section 5.5
com.stc.eways.jdbcx.CallableStatementAgent Class

getArray on page 116 getBigDecimal on page 113
getBlob on page 117 getBoolean on page 111

getByte on page 111 getBytes on page 116

getClob on page 117 getDate on page 113

getDate on page 114 getDouble on page 113

getFloat on page 112 getInt on page 112

getLong on page 112 getODbject on page 110

getObject on page 110 getRef on page 117

getShort on page 111 getString on page 116

getTime on page 114 getTimestamp on page 115
getTimestamp on page 115 registerOutParameter on page 108
registerOutParameter on page 109 registerOutParameter on page 109
sessionOpen on page 108 wasNull on page 110

Constructor CallableStatementAgent

Creates new CallableStatementAgent with scroll direction TYPE_FORWARD_ONLY

and concurrency CONCUR_READ_ONLY.

public CallableStatementAgent (Session session, java.lang.String

sCommand)
Name Description
session Connection session.
sCommand The Call statement used to invoke a stored
procedure.

Constructor CallableStatementAgent

Creates a new CallableStatementAgent.
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public CallableStatementAgent (Session session,

Section 5.5
com.stc.eways.jdbcx.CallableStatementAgent Class

int iScroll, int

iConcur)
Name Description
session Connection session.
iScroll Ignored.
iConcur Ignored

Constructor CallableStatement Agent

Creates a new CallableStatementAgent.

public CallableStatementAgent (Session session,

java.lang.String

sCommand, int iScroll, int iConcur)
Name Description

session Connection session.

sCommand The Call statement used to invoke a stored
procedure.

iScroll Scroll direction: TYPE_LFORWARD_ONILY,

iConcur Concurrency: CONCUR_READ_ONLY,
CONCUR_UPDATEABLE

sessionOpen

Opens the session event handler.

public void sessionOpen (SessionEvent evt)

Overrides

sessionOpen in class PreparedStatementAgent

Name

Description

evt

Session event.

registerOutParameter

Registers the indexed OUT parameter with specified type.

public void registerOutParameter (int index,
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Name Description
index Parameter index starting from 1.
iType A JDBC type defined by inava.sql.Types.
Throws
java.sql.SQLException

registerOutParameter

Registers the indexed OUT parameter with specified type and scale.

public void registerOutParameter (int index, int iType, int iScale)

Name Description
index Parameter index starting from 1.
iType A JDBC type defined by inava.sql.Types.
iScale The number of digits to the right of the
decimal point. Only applied to DECIMAL
and NUMERIC types.

Throws

java.sql.SQLException

registerOutParameter

Registers the indexed OUT parameter with specified user-named type or REF type.

public void registerOutParameter (int index, int iType,
java.lang.String sType)

Name Description
index Parameter index starting from 1.
iType A JDBC type defined by inava.sql.Types.
tName The fully-qualified name of the parameter
being set. It is intended to be used by REF,
STRUCT, DISTINCT, or JAVA_OBJECT.

Throws

java.sql.SQLException

e*Way Intelligent Adapter for Sybase User’s Guide 109 SeeBeyond Proprietary and Confidential



Chapter 5 Section 5.5
Sybase e*Way Methods com.stc.eways.jdbcx.CallableStatementAgent Class

wasNull
Returns whether or not the last OUT parameter read had the SQL NULL value.

public boolean wasNull ()
Returns

true if the parameter read is SQL NULL; otherwise, false
Throws

java.sql.SQLException

getObject

Gets the value of the indexed parameter as an instance of Object.

public java.lang.Object getObject (int index)

Name Description
index Parameter index starting from 1.
Returns
The Object value
Throws
java.sql.SQLException
getObject

Gets the value of the indexed parameter as an instance of Object and uses map for the
customer mapping of the parameter value.

public java.lang.Object getObject(int index, java.util.Map map)

Name Description
index Parameter index starting from 1.
map A Map object for mapping from SQL type

names for user-defined types to classes in
the Java programming language.

Returns
An Object value
Throws

java.sql.SQLException
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getBoolean

Gets the boolean value of the indexed parameter.

public boolean getBoolean (int index)

Name Description

index Parameter index starting from 1.

Returns
A boolean value
Throws

java.sql.SQLException

getByte
Gets byte value of the indexed parameter.

public byte getByte(int index)

Name Description
index Parameter index starting from 1.
Returns
A byte value
Throws
java.sql.SQLException
getShort

Gets short value of the indexed parameter.
public short getShort (int index)
Returns

A short value
Throws

java.sql.SQLException
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getint

Gets integer value of the indexed parameter.

public int getInt (int index)

Name Description
index Parameter index starting from 1.
Returns
A int value
Throws
java.sql.SQLException
getlLong

Gets long value of the indexed parameter.

public long getLong(int index)

Name Description
index Parameter index starting from 1.
Returns
A long value
Throws
java.sql.SQLException
getFloat

Gets float value of the indexed parameter.

public float getFloat (int index)

Name Description

index Parameter index starting from 1.

Returns

A float value
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Throws

java.sql.SQLException

getDouble

Gets double value of the indexed parameter.

public double getDouble(int index)

Name Description
index Parameter index starting from 1.
Returns
A float value
Throws
java.sql.SQLException
getBigDecimal

Gets decimal value of the indexed parameter.

public java.math.BigDecimal getBigDecimal (int index)

Name Description
index Parameter index starting from 1.
Returns
A BigDecimal object
Throws
java.sql.SQLException
getDate

Gets date value of the indexed parameter.

public java.sqgl.Date getDate(int index)

Name Description

index Parameter index starting from 1.
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Returns
A Date object
Throws

java.sql.SQLException

Section 5.5
com.stc.eways.jdbcx.CallableStatementAgent Class

getDate

Gets date value of the indexed parameter with time zone from calendar.

public java.sqgl.Date getDate(int index, java.util.Calendar calendar)

Name

Description

index

Parameter index starting from 1.

cal

The Calendar object used to construct the

timestamp.

Returns
A Date object
Throws

java.sql.SQLException

getTime

Gets time value of the indexed parameter.

public java.sgl.Time getTime (int index)

Name

Description

index

Parameter index starting from 1.

Returns
A Time object
Throws

java.sql.SQLException

getTime

Gets time value of the indexed parameter with time zone from calendar.

public java.sgl.Time getTime (int index, java.util.Calendar calendar)
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Name Description
index Parameter index starting from 1.
cal The Calendar object used to construct the
timestamp.
Returns

A Time object
Throws

java.sql.SQLException

getTimestamp

Gets timestamp value of the indexed parameter.

public java.sgl.timestamp getTimestamp (int index)

Name Description

index Parameter index starting from 1.

Returns
A Timestamp object
Throws

java.sql.SQLException

getTimestamp

Gets timestamp value of the indexed parameter.

public java.sqgl.timestamp getTimestamp (int index, java.util.Calendar

calendar)
Name Description
index Parameter index starting from 1.
cal The Calendar object used to construct the
timestamp.
Returns

A Timestamp object
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Throws

java.sql.SQLException

getString

Gets string value of the indexed parameter.

public java.lang.String getString(int index)

Name Description
index Parameter index starting from 1.
Returns
A String object
Throws
java.sql.SQLException
getBytes

Gets byte array value of the indexed parameter.

public byte[] getBytes(int index)

Name Description
index Parameter index starting from 1.
Returns
An array of bytes
Throws
java.sql.SQLException
getArray

Gets Array value of the indexed parameter.

public java.sql.Array getArray (int index)

Name Description

index Parameter index starting from 1.
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Returns
An Array object
Throws

java.sql.SQLException

getBlob

Gets Blob value of the indexed parameter.

public java.sqgl.Blob getBlob(int index)

Name Description
index Parameter index starting from 1.
Returns
A Blob object
Throws
java.sql.SQLException
getClob

Gets Clob value of the indexed parameter.

public java.sgl.Clob getClob(int index)

Name Description
index Parameter index starting from 1.
Returns
A Blob object
Throws
java.sql.SQLException
getRef

Gets Ref value of the indexed parameter.

public java.sqgl.Ref getRef (int index)
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Name Description
index Parameter index starting from 1.
Returns
A Ref object
Throws
java.sql.SQLException

s6 com.stc.eways.jdbcx.TableResultSet Class

java.lang.Object

+ -- com.stc.eways.jdbcx.StatementAgent
|
+ -- com.stc.eways.jdbcx. TableResultSet
All Implemented Interfaces
ResetEventListener, SessionEventListener

public abstract class TableResultSet

extends StatementAgent

ResultSet to map selected records of table in the database

Methods of the TableResultSet

absolute on page 120
beforeFirst on page 121
deleteRow on page 124

first on page 120
getAsciiStream on page 123
getBinaryStream on page 123
getCharacterStream on page 124
isAfterLast on page 122

isFirst on page 121

last on page 121

moveTolnsertRow on page 124
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afterLast on page 122
cancelRowUpdates on page 125
findColumn on page 122
getAsciiStream on page 123
getBinaryStream on page 123
getCharacterStream on page 123
insertRow on page 124
isBeforeFirst on page 122

isLast on page 121
moveToCurrentRow on page 125

next on page 119
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previous on page 119
rowDeleted on page 125
rowUpdated on page 125
updateRow on page 124

Section 5.6
com.stc.eways.jdbcx.TableResultSet Class

relative on page 120
rowlInserted on page 125
select on page 119
wasNull on page 126

select

Select table records.

public void select(java.lang.String sWhere)

Name Description
sWhere Where condition for the query.
Throws
java.sql.SQLException
next

Navigate one row forward.

public boolean next ()

Returns

true if the move to the next row is successful; otherwise, false.

Throws

java.sql.SQLException

previous

Navigate one row backward. It should be called only on ResultSetAgent objects that are

TYPE_FORWARD_ONLY.

public boolean previous ()

Returns

true if the cursor successfully moves to the previous row; otherwise, false.

Throws

java.sql.SQLException
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absolute

Move cursor to specified row number. It should be called only on ResultSetAgent
objects that are TYPE_FORWARD_ONLY.

Name Description

row An integer other than 0.

Returns

true if the cursor successfully moves to the specified row; otherwise, false.

Throws

java.sql.SQLException

relative

Move the cursor forward or backward a specified number of rows. It should be called
only on ResultSetAgent objects that are TYPE_FORWARD_ONLY.

public boolean relative(int rows)

Name Description

rows The number of rows to move the cursor,
starting at the current row. If the rows are
positive, the cursor moves forward; if the
rows are negative, the cursor moves
backwards.

Returns

true if the cursor successfully moves to the number of rows specified; otherwise, false.

Throws

java.sql.SQLException

first

Move the cursor to the first row of the result set. It should be called only on
ResultSetAgent objects that are TYPE_FORWARD_ONLY.

public boolean first()
Returns

true if the cursor successfully moves to the first row; otherwise, false.
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Throws

java.sql.SQLException

isFirst
Check if the cursor is on the first row. It should be called only on ResultSetAgent
objects that are TYPE_FORWARD_ONLY.

public boolean isFirst()

Returns
true if the cursor successfully moves to the first row; otherwise, false.
Throws

java.sql.SQLException

last

Move to the last row of the result set. It should be called only on ResultSetAgent objects
that are TYPE_FORWARD_ONLY.

public boolean last ()
Returns

true if the cursor successfully moves to the last row; otherwise, false.
Throws

java.sql.SQLException

isLast

Check if the cursor is positioned on the last row. It should be called only on
ResultSetAgent objects that are TYPE_FORWARD_ONLY.

public boolean isLast ()

Returns
true if the cursor is on the last row; otherwise, false
Throws

java.sql.SQLException

beforeFirst

Move the cursor before the first row. It should be called only on ResultSetAgent objects
that are TYPE_FORWARD_ONLY.

public void beforeFirst ()
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Throws

java.sql.SQLException

isBeforeFirst

Check if the cursor is positioned before the first row. It should be called only on
ResultSetAgent objects that are TYPE_FORWARD_ONLY.

public boolean isBeforeFirst()

Returns
true if the cursor successfully moves before the first row; otherwise, false
Throws

java.sql.SQLException

afterLast

Move the cursor after the last row.It should be called only on ResultSetAgent objects
that are TYPE_FORWARD_ONLY.

public void afterLast ()
Throws

java.sql.SQLException

isAfterLast

Returns true if the cursor is positioned after the last row. It should be called only on
ResultSetAgent objects that are TYPE_FORWARD_ONLY.

public boolean isAfterLast ()

Returns true if the cursor successfully moves after the last row; otherwise, false.
Throws

java.sql.SQLException

findColumn

Finds the index of the named column.

public int findColumn(java.lang.String index)
Throws

java.sql.SQLException
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getAsciiStream

Returns the column data as an AsciiStream.

public java.io.InputStream getAsciiStream(int index)

Throws

java.sql.SQLException

getAsciiStream

Returns the column data as an AsciiStream.

public java.io.InputStream getAsciiStream(java.lang.String
columnName)

Throws

java.sql.SQLException

getBinaryStream

Returns the column data as BinaryStream.

public java.io.InputStream getBinaryStream(int index)

Throws

java.sql.SQLException

getBinaryStream

Returns the column data as BinaryStream.

public java.io.InputStream getBinaryStream(java.lang.String
columnName)

Throws

java.sql.SQLException

getCharacterStream

Returns the column data as CharacterStream.

public java.io.Reader getCharacterStream(int index)

Throws

java.sql.SQLException
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getCharacterStream

Returns the column data as CharacterStream.

public java.io.Reader getCharacterStream(java.lang.String columnName)

Throws

java.sql.SQLException

refreshRow

Refreshes the current row with its most recent value from the database.

public void refreshRow()

Throws

java.sql.SQLException

insertRow

Inserts the contents of the current row into the database.

public void insertRow ()

Throws

java.sql.SQLException

updateRow

Updates the contents of the current row into the database.

public void updateRow ()
Throws

java.sql.SQLException

deleteRow

Deletes the contents of the current row from the database.

public void deleteRow ()
Throws

java.sql.SQLException

moveTolnsertRow

Moves the current position to a new insert row.

public void moveToInsertRow ()
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Throws

java.sql.SQLException

moveToCurrentRow

Moves the current position to the current row. It is used after you insert a row.

public void moveToCurrentRow ()

Throws

java.sql.SQLException

cancelRowUpdates

Cancels any updates made to this row.

public void cancelRowUpdates ()

Throws

java.sql.SQLException

rowlnserted

Returns true if the current row has been inserted.

public boolean rowInserted()

Throws

java.sql.SQLException

rowUpdated

Returns true i the current row has been updated.

public boolean rowUpdated()
Throws

java.sql.SQLException

rowDeleted

Returns true if the current row has been deleted.

public boolean rowDeleted()

Throws

java.sql.SQLException
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wasNull

Returns true if the last data retrieved is NULL.

public boolean wasNull ()
Throws

java.sql.SQLException
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